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Send Us Your Comments

Oracle® Retail Process Orchestration and Monitoring User Guide

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this
document.

Your feedback is important, and helps us to best meet your needs as a user of our products.
For example:

*  Are the implementation steps correct and complete?

* Did you understand the context of the procedures?

* Did you find any errors in the information?

* Does the structure of the information help you with your tasks?

* Do you need different information or graphics? If so, where, and in what format?
* Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your
name, the name of the company who has licensed our products, the title and part number of
the documentation and the chapter, section, and page number (if available).

# Note:

Before sending us your comments, you might like to check that you have the latest
version of the document and if any concerns are already addressed. To do this,
access the Online Documentation available on the Oracle Technology Network Web
site. It contains the most current Documentation Library plus all documents revised
or released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com
Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative
or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle
local office and inquire about our Oracle University offerings. A list of Oracle offices is
available on our Web site at http://www.oracle.com.
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The Oracle Retail Process Orchestration and Monitoring User Guide describes the
tracking and managing of batch jobs.

Audience

This guide is for system administrators and operations personnel, integrators and
implementation staff personnel as well as users of the module.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:
https://support.oracle.com

When contacting Customer Support, please provide the following:

*  Product version and program/module name

* Functional and technical description of the problem (include business impact)

* Detailed step-by-step instructions to re-create

» Exact error message received

»  Screen shots of each step you take

Oracle Help Center (docs.oracle.com)

Oracle Retail Product documentation is available on the following website https://
docs.oracle.com/en/industries/retail/html

Comments and Suggestions

Please give us feedback about Oracle Retail Help and Guides. You can send an e-mail
to: retail-doc_us@oracle.com
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Preface

Oracle Retail Cloud Services and Business Agility

Oracle Retail (Product Name) Cloud Service is hosted in the Oracle Cloud with the security
features inherent to Oracle technology and a robust data center classification, providing
significant uptime. The Oracle Cloud team is responsible for installing, monitoring, patching,
and upgrading retail software.

Included in the service is continuous technical support, access to software feature
enhancements, hardware upgrades, and disaster recovery. The Cloud Service model helps to
free customer IT resources from the need to perform these tasks, giving retailers greater
business agility to respond to changing technologies and to perform more value-added tasks
focused on business processes and innovation.

Oracle Retail Software Cloud Service is acquired exclusively through a subscription service
(SaaS) model. This shifts funding from a capital investment in software to an operational
expense. Subscription-based pricing for retail applications offers flexibility and cost
effectiveness.



Common User Interface Controls

Oracle Retail applications, such as the Oracle Retail Process Orchestration and Monitoring
(POM) application, include some common interface options and controls that you can use
throughout the application workflow. The following sections describe these user interface
controls in more detail.

Although you may have more than one Oracle Retail application installed on your system,
each application may use many of the same interface components and abide by common
rules and constraints.

You can quickly access the tasks of current applications and switch to other applications from
the Navigation bar. For more information on the Navigation bar, see the Navigation Area
section.

The following topics are covered in this chapter:
* Logging on to the Application

* Navigation Area

*  Table Menu Options

» Logging Out of the Application

Logging on to the Application

ORACLE

To log on to the application:

1. Go to the URL for the application in a web browser.

The Welcome Screen opens.

1-1
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Figure 1-1 Welcome Screen

ORACLE Cloud

rgbudevsandbox

Oracle Cloud Account Sign In

User Name

User name or email

Password

Password

Need help signing in? Click here

Cookie Preferences

2. Provide the following login information:
a. Enter your user name in the Username field.
b. Enter your password in the Password field.

3. Click Login.

Navigation Area

You can quickly access the tasks of current applications and switch to other
applications from the Navigation bar.

ORACLE" 1-2
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Figure 1-2 Navigation Bar

e

vy <— Favorites

<+——— Tasks
@ <+—— Notifications

n[||] <+—— Reports

e <+—— Settings Menu

The following Navigation bar options are common across all the applications:

Favorites
Tasks
Notifications
Reports
Settings

The Favorites option provides the ability to bookmark the templates that are used frequently
by a user. It provides quick and easy access to frequently used workflows. These bookmarks
save you navigation time through the task list and allow you to access commonly used
templates quickly. Favorites menu can be accessed using the star icon available on the left-
side menu bar.
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Figure 1-3 Favorites Menu

Oracle Retail Proces

Q, Search for a favorite

Batch Monitoring

Favorites
@
ol

Audit Events
Align Business Dates

Batch Administration

Mark as Favorite

By clicking the star icon next to a task name, you can add a task to the Favorites list. A
full star next to a task name indicates that it is a Favorite. The icon is visible only when
you hover over the task. New favorites are always added to the end of the list, and
they can be reordered in the Edit Favorites page.

Figure 1-4 Mark as Favorite

ﬁ Tasks
Q, Search for a task
@ * Batch Monitoring
ol System Configuration
* Batch Administration
77 Scheduler Administration
Mark as Favorite ince

AMS Utilities >
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Unmark as Favorite

By clicking the star icon next to a task name, you can remove a task from the Favorites list.
An empty star next to a task name indicates that it is not a Favorite. The icon is visible only
when you hover over on the task.

Figure 1-5 Unmark as Favorite

~ W Batch Monitoring
I!II]'] System Configuration

* Batch Administration

Unmark as Favorite ;5

Schedule Maintenance

AMS Utilities ?

Pin Favorite

By clicking the pin icon in the Favorites menu, a favorite task can be pinned to the navigation
bar to easily access them. A full pin next to a task name indicates that it is pinned. To unpin a
task, click the pin icon again to display an empty pin icon. Pinned favorites can also be
managed from the Edit Favorites page.

Figure 1-6 Pin Favorite

Favorites

Q. Search for a favorite

= Batch Monitoring
oll0

Pin Favorite

Align Business Dates

Batch Administration
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Figure 1-7 Pinned Favorite in Navigation Bar

= Oracle Retail Proces

E Favorites

Q Search for a favorite

= o Batch Monitoring

“l]u Audit Events
Align Business Dates
&

Ratrh ﬂ.rlminiqtration
Batch Monitoring

Chapter 1
Navigation Area

You can also unpin or remove a pinned favorite on the navigation bar by using the
context menu option, removing it from Favorites. The context menu option allows you

to open the Edit Favorites page.

Figure 1-8 Unpin Favorite

Favorites

‘ Q_ Search for a favorite

< of* Batch Monitoring
oll <7 Audit Events
E’g Align Business Dates
Unpin Favorite
Unpin and Remove Favorite

Edit Favorites

ORACLE
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Search Favorites

You can also search the bookmarked tasks in the Favorites menu by using the search option.
Start typing in the search input to find the matching favorite task and then select a favorite
from the search result to open that task.

Figure 1-9 Search Favorites

E Favorites ‘

Q Audit ‘

-

+  Audit Events

]

ol Audit Events
Align Business Dates
12

Batch Administration

Edit Favorite Window

You can organize, rename, pin and unpin Favorites in the Edit Favorites window. Click Edit
Favorites on the footer for the Favorites menu to open the Edit Favorites window.

ORACLE 1-7
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Figure 1-10 Edit Favorite

Oracle Retail Proces

Favorites

Ly

-~

all0

1!

Q bearch for a favorite

of* Batch Monitoring
Audit Events
Align Business Dates

Batch Administration

Edit Favorites

Chapter 1
Navigation Area

1-8



Tasks

ORACLE

Chapter 1
Navigation Area

Figure 1-11 Edit Favorites Window

Edit Favorites =
Organized Favorites Pinned Navigation Bar Favorites
J— @ T
[
Y g Busioess ones
[ ek Adiasratin
~ &

Following actions can be performed from Edit Favorites window:

* Create Folder

» Edit a Favorite or Folder
» Delete Favorite or Folder
* Organize Favorites

e Toggle a Pin

* Pinned Navigation Bar Favorites

Oracle Retail applications support a variety of navigational tools and methods that allow you
to move efficiently between application pages. Information on how to use and manage each
of the tools and methods is included in this section.

A task is a set of links to a series of task flows organized in a specific sequence to
accomplish a business process or procedure. For example, tasks can be defined for common
multi-step procedures or processes so that you can quickly step through tasks. By navigating
sequentially to the pages outlined in the task, you are assisted in stepping through the
business process or activity.

Your Tasks list appears on the top left side of the home page. All of the tasks to which you
have access are listed on the Tasks window. You can either click on the specific task name to
open or use the Task Search component to search for a Task that you want to open.

To begin working with a task, choose the application feature or process from the list.
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< Note:

Your task menu may appear slightly different, depending on your retail
application.

Figure 1-12 Tasks Menu

~ Batch Monitoring
'ﬂu System Configuration

Batch Administration
Scheduler Administration
Schedule Maintenance

AMS Utilities >

Notifications

The Notifications option brings events within the application to your attention.

See the following examples:

ORACLE 1-10



Figure 1-13 Notifications

g

Notification Badge

The Notification Badge displays the number of unread notifications for the user in the sidebar
menu. The Notification Badge displays '99+' when there are more than 99 notifications.

ORACLE

Notifications

Q. search for a notific:

Filters

@ Batch execution error
Critical

AIF DATA :: Job GENERIC_BAT...

6,/17/23, 11:30:56 AM
POAM_ADMIN

@ Nightly cycle start

Normal

AIF DATA :: Nightly batch cydl...

6/17/23, 11:30:01 AM
POAM_ADMIN

® Intraday cycle completion
Normal

AIF DATA :: Intraday batch cyc...

6/16/23, 5:00:01 PM
POAM_ADMIN

Chapter 1
Navigation Area

The notification count is periodically refreshed at regular intervals. This interval is determined
by a system-configured value.

Figure 1-14 Notification Badge

& =

Ty
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Notification Sidebar

When you click the Notification icon, a Notifications Sidebar is shown that displays the
most recent set of unread notifications in the notifications screen (depending on the
filter set).

Figure 1-15 Notifications Sidebar

' Search Bar
}:{ l Notifications
Q, search for a notific: = «— Toggle View
[ iHbes}
= Filters « <+ Filtering Panel
l:II]|] ® Batch execution error
Critical

AIF DATA :: Job GENERIC_BAT...
&/17/23, 1:30:56 AM
FOshLADA <+—— Search Result Panel

@ Nightly cycle start

Normal
AIF DATA :: Nightly batch cycl...
6/17/23, 11:30:01 AM
POAM_ADMIN

@ Intraday cycle completion

Normal

AIF DATA :: Intraday batch cyc...
6/16/23,5:00:01 PM
POAM_ADMIN

@ POM Upgrade Post Install Va...
Critical

:: POM Post Install Validation ...
6/15/23,1:34:06 PM
POAM_ADMIN

{EE See All <+—— All Notifications Tab

When Toggle View is activated:

ORACLE 1-12



Chapter 1
Navigation Area

g Notifications
Q, Search for a notific: | | [=

’1 -
Filters ¥  GroupBy 0 v = Grouping Panel

l:II][l Batch schedule import events

® Batch schedule import events

E/'J Normal
RPAS :: Batch Schedule impor...
6/23/23,7:30:59 PM

POAM_ADMIN

® Batch schedule import events ‘ Groupe d Notifications

MNormal
AIF DATA :: Batch Schedule i...

6/23/23, 5:10:59 PM
POAM_ADMIN

® Batch schedule import events

Normal
AlF DATA :: Batch Schedule ...
6/9/23, 7:43:18 PM
POAM_ADMIN

= See More

Each component of the Notifications Sidebar is discussed in detail in the following sections.

Search Bar

A search bar at the top of the panel allows for searching through notifications. The search bar
has auto-suggest enabled, so it displays notifications as the user types.

Right next to the search bar is the 'List/Group' view toggle button. This causes the Notification
results to be displayed either in a flat or grouped view.

ORACLE 1-13



Figure 1-16 Search Bar

‘:{ Notifications

Q import

import is completed

ol

successfully for the

upgrade of Schedule
‘RPAS' from

E"l version[23.1.20119] to
version[23.1.201.20] .

RPAS :: Batch Schedul
import started
successfully for the
upgrade of Schedule
{ 'RPAS' from
version[231.20119] to
version[23.1.201.20] .

RPAS :: Batch Schedul

e A P ey P |

@ Batch execution error

Critical

AIF DATA :: Job RUN_PARTITI...

6/23/23, 5:20:21PM
POAM_ADMIN

Filtering Panel

ORACLE

|

3
r:‘ RPAS :: Batch Schedul '

events

impor...

[L_DE...

jon

ch cyc...

Chapter 1
Navigation Area

The Filtering Panel allows you to filter notifications based on the creation Time Period,

Type and Severity.

The values for the Time Period and Severity components are pre-seeded constants.

The Type drop-down lists all the natification types available in the system.

When you click the Apply button, notifications that match the criteria are shown in the

Results Panel.

1-14
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Figure 1-17 Filtering Panel

ﬂ. Notifications

Q, Search for a notific: | | E=

=
Filters - Group By o N

I!II]'] Time Period
Any v
1%
Type

All

Severity

All

Reset Cancel Apply

Grouping Panel

This panel allows you to group notifications based on different attributes.

The values of the 'Group by' and the 'Then by' components are pre-seeded.
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Figure 1-18 Grouping Panel

ﬁ Notifications

Q, Search for a notific: =

)
Filters W Grnupﬁyo -

I:II]" Group By

Type v
1%
Then By
No Selection v
Reset Cancel Apply

Results Panel - List View

Chapter 1
Navigation Area

When no selection is made in the Grouping panel, the Results Panel displays

notifications in a list format.

The image below shows a simple search without any filtering or grouping.

ORACLE
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Figure 1-19 Results Panel - List View

Notifications

Q, Search for a notifice I=

Filters ? ¥  Group By o w

Indicates that a filter was applied
Batch execution error

Batch execution error «—— Notification Type - Description
Critical
RI :: Job FACTCLOSE_W_RTL....
6/26/23,2:16:54 PM
POAM_ADMIN Read /Unread - A blue icon is shown
next to the notification if it is unread.

® Batch execution error

Critical * Notification Severity

Rl :: Job FACTCLOSE_W_RTL._... ¢¥——— ]Ob Description
6/26/23,2:16:01PM < Notification Creation Time
POAM_ADMIN < Notification Creator

® Batch execution error
Critical
Rl :: Job FACTCLOSE_W _RTL._...
6/26/23,2:16:01 PM
POAM_ADMIN

= See More

Results Panel - Grouped View

Results Panel - Grouped View

Notifications are displayed in a grouped format within the Results panel, when the Group By
drop-down in the Grouping Panel is selected.

Notifications are displayed in groups with three notifications shown for each group.

ORACLE 1-17
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Figure 1-20 Results Panel - Grouped View

ﬁ Notifications

Q Search for a notifice E

% Indicates the Group-By drop-down
< Fiters ) v GroupBy ) *~— is selected on the Grouping Panel.

ol 06/23/2023 & The value of the Group-By attribute.
In this example, the results were
grouped by Business Date

@ Batch execution error

= Critical
Rl :: Job FACTCLOSE_W_RTL_...

6/26/23, 2:16:54 PM
POAM_ADMIN

® Batch execution error

Critical

Rl :: Job FACTCLOSE_W_RTL_...
6/26/23, 2:16:01 PM
POAM_ADMIN

® Batch execution error

Critical
RI:: Job FACTCLOSE_W_RTL ...

6/26/23, 2:16:01 PM
POAM_ADMIN

= See More

For each group, three notifications are shown followed by a 'See More' link. When you
click this link, up to 25 notifications are displayed for that group.

Results Panel - Summarized View

Notifications are summarized as shown in this example, when both the Group By and
the Then By dropdowns in the Grouping Panel are selected.

The summary view displays various groups and within them subgroups based on the
selections on the Grouping panel. For each subgroup, a count of the notifications
within that subgroup, grouped by severity is displayed.

The example here depicts a grouping by department, then by class.

ORACLE 1-18
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Figure 1-21 Results Panel - Summarized View

w

Notifications

Q, Search for a notific:

50 - .
Fiters v GroupBy ) «v—— [ndicates that both options on the

Notifications Tab

&

Grouping Panel have been selected.

Batch execution error
l First level of grouping is by Type

Rl =

20 Critical

6/26/23, 2:16:54 PM

Intraday cycle completion

1 Normal

6/26/23,1:50:18 PM
Nightly cycle start

which is “Batch execution error”

The subgroup within Type ‘Batch

execution error’ is ‘Schedule Name’.

0 The number of notifications within that
combination of Group and Subgroup

0 A grouping by severity of all
notifications within that combination

<
1 Normal ¥

6/26/23,1:40:01 PM
Intraday Cycle skipped

1Normal

of Group and Subgroup.

The timestamp of the most recent
notification of that combination of

6/26/23,1:40:01 PM <

Group and Subgroup.

The Notifications tab opens when you click the 'See All' link at the bottom of the Notifications
side panel.

ORACLE
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Figure 1-22 Notifications Tab

BB D

5]

Mentae. X

= Al Neoficaton  © Alllesad @ Crmcal A Irpomant @ Mormal | O Fiter Apphed
1307 -l
0 = o © 1\;:
= s
Actions v View ¥ & B pess
Severity & Status & Descripsion © Type @ Merts Recigients Creation Date = Created By © Ltpaie. = Tis
Critical [ ) = Job FACTCLOSE W_RTL_CO_LINE_STATUS F_J08 Butch swscution ermer POAM_ADM®N T8, 1S4 P POAM_ADMAN EFDESTL, PS4 P L=
Critical [ ] = Job FACTCLOSE_W_RTL_MNVULIT_LC WICA_JOB F Butch ewecution emar POAM_ADMBY 20T, WD PM POAM_ADRAN 20T, 2001 P PC
Criical [ ] 2 Job FACTCLOSE W_RTL_COMP_PRICE_IT_LC G N Butch exscution srmer POAS_ADMSN &F2ETY, PR PM POAM_ADMN 62625, 23500 P pC
Critical [ ] 1= Job FACTCLOSE W_RTL_CO_LINE_STATUS G_JO8 Batch execution emor POAM_ADMMN 8/20/25, 300 PM POAM_ADMN B/20/75 1000 PM PC
Critieal [ ] = Job FACTCLOSE_W_RTL_MV_IT_LC_OW_F_JOB Fail Butch esseution sirer POAM_ADMMN &/26/25, 23500 PM POAM_ADMEN B26,/23, 21600 P PO
Critical L ] Rz Job FACTCLOSE_ W_RTL_BCOST_ITLC_DV_F_JOB Batch execution emor POMAM_ADMB 6/26/25, 2400 PM POAM_ADRAN /20,78, 21000 PM PQ
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This tab lists all the notifications for the logged-in user, regardless of whether they are
in Read or Unread status. Information tiles display a break-up of the total notifications
by severity. Clicking these tiles refreshes the table below to display only those
notifications that are relevant to that tile.

You can perform the following operations from this tab.

Delete *< - The table allows for multiple selection and hence multiple notifications
can be deleted at a time. Use the row header to select the row.

Refresh “_* - This refreshes the list of notifications in the table.

Mark as Read - Multiple Unread Notifications can be marked as Read by clicking
this button.

Mark as Unread - Multiple Read Notifications can be marked as Unread by clicking
this button.

Reassign Notifications y Notifications can be reassigned to individual recipients
or a group by clicking the Reassign Natifications icon. On selecting a row in the All
Notifications table, and clicking the icon, the reassign notification popup is
displayed. The Type is set to Reassigned by default, and the Severity and
Description are pre-populated from the selected row; you can then change any of
these values and assign the notification to one or more recipients.
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Figure 1-23 Reassign Notification

Reassign Notification ~
Severity Type

Cri tical' hd Reassigned v
Description

Rl :: Job FACTCLOSE_W_RTL_CO_LINE_STATUS_F_JOB Failed
for 23-JUN-23

Choose Recipients Selected

Search for recipient 0

Cancel OK

The All Notifications table displays the following columns:

*  Severity - A colored label indicating the Notification Severity.

*  Status - If the status is unread, an icon # is shown. Otherwise, it is blank.
»  Description - The description of the notification itself.

*  Type- The description of the Notification Type for the notification.

* Alerts -

* Recipients - In case of individual notifications, this column contains the user ID of the
user to whom the notification is assigned. When the notification is assigned to multiple
users, it displays the text 'Multiple' and enables a context popup which lists all the
recipients. This field is empty when the notification is assigned to a group associated with
a type.

* Creation Date - Timestamp showing the date and time of creation.
*  Created By - User ID of the user who created the notification.

* Last Updated Date - Timestamp showing the date and time when the last update was
made.

e Last Updated By - User ID of the user who last updated the natification.

» Application ID - Unique identifier that identifies the application. Not visible by default.
* Department - The Department associated with the notification. Not visible by default.
* Class - The Class associated with the notification. Not visible by default.

* Subclass - The Subclass associated with the notification. Not visible by default.

* Location - The Location associated with the notification. Not visible by default.

»  Supplier - The Supplier associated with the notification. Not visible by default.
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 Performance - The Performance value associated with the notification. Not visible
by default.

» Brand - The Brand associated with the notification. Not visible by default.

* Rollup Count - The Rollup Count associated with the notification. Not visible by
default.

» Additional Information - Refers to the Additional Information attribute associated
with the notification. Not visible by default.

Reports

The functionality of Reports works similar to the Tasks menu.

Settings

The Settings icon on the Navigation Bar displays the application's Settings menu when
clicked. This menu differs per application and for POM, it contains the Application
Properties menu item.

Settings
Q. Search for a setting

Application Properties

Application Properties

Application properties are key-value pairs of parameters and configuration settings
used by POM to operate efficiently and to control the application's behavior. For
instance, a property may exist to turn off certain features within the application or to set
limits on different event timings. This screen is restricted to administrators as
application inner-working expertise is needed for understanding the impact of each

property.

Application properties are grouped by Deploy Names, so one needs to be provided for
the search to return results.

Each property is provided with a default value in case a property value is not set. Each
is also provided with a Deployment Restart attribute, which indicates whether a server
restart is needed for a new value to take effect.
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The Application Properties page provides the following features:

e Search for application properties
*  Filter application properties

e Sort application properties

» Update the value of an application property using the Edit Property dialog shown below:

Edit Property

Key APPAREL mdf symc.unmatched.modules.resohe

Key Name MDF Syncing strategy for APPAREL schedule

_ Key This property will used to determine how to sync unmatched modules
Description in MDF, Valid values for this property are IGNORE and DISABLE. By

bl i b Ln mms am B RAPEE

Deploy Hame POM

Category POM Process Services properties

Table Menu Options

" Note:

Category
Deseription

Defaiilt Value

Deployrment
Restart

Current Value

Last Updated
By

Last Updated
Date

Configurable Process Services Model properties

IGNORE

ResettoDetautt | | Cancel

Figure 1-24, Figure 1-25 are representations and may be different for every window/

table/popup.

ORACLE"
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The Actions menu, View menu, and icons are displayed in the form of a table. For
more information on these options, see the sections Action Menu and Icons and View
Menu.

Action Menu and Icons

View Menu

ORACLE

The Actions menu provides the option to take different actions related to entries in the
table. Depending on the nature of the table, these actions can be add, view, delete or
edit table rows, create by moving to a new screen or export the table contents to the
spreadsheet. Alternatively these actions can also be performed by using the icon
buttons on the table toolbar. For more information on the icon/buttons, see the Screen
Level Action - Icons and Buttons.

In some tables, it may also contain some table specific actions.

Figure 1-24 Action Menu and Icons

Actions ¥ View ¥ 2 |'Y [ petacn
Filter Filter
Key Name < Key ¢

Refresh MDF Syncing strategy for APPAREL schedule  APPAREL.md|

POM MDF Version for APPAREL schedule APPAREL.md!

Table 1-1 Actions Menul/lcons and Descriptions

Actions Menullcon Description

Refresh and Refresh icon  Select Actions > Refresh or the Refresh icon “.* to update

O the records in the table.

Filter icon T Select the Filter icon ¥ to open fields that will filter the
results.

Use the filter fields to only show the rows matching or
containing the entered information.

Detach and Detach Icon & Select Actions > Detach or the Detach icon & to open the
table in a separate window.

The View menu provides the options for managing the table columns and sorting and
filtering the table data.

In some tables you have the option to choose a saved custom view, which is an
arrangement of columns different from the default view of the table.
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Actions ¥ View « 2 |'Y [ petach

Manage Columns £l

Deploy Name Key
Detach

POM ‘or APPAREL schedule ~ APP2
Sort

POM REL schedule APPA

POM v/ Query by Example  ag for APPAREL schedul APPA

POM Throttling Sync Strategy for APPAREL schedule APP2

Table 1-2 View Menu/lcons and Descriptions
- ______________________________________________________________________________]

View Menu List

Description

Manage Columns

Detach and Detach icon &

Query by Example

You can show or hide columns and change the order of the
columns by selecting View > Manage Columns.

This View menu option is only available for tables with a large
number of columns.

Note that the changes performed on the Manage Columns popup
are persisted on the browser's cache and therefore are lost when
the cache is cleared or when the browser is changed. Persistence
of column preferences will be switched to the database in a
future release, thereby preserving those preferences even when
browser cache is cleared or when the browser is changed.

You can view the tables in the application in a separate window
by selecting View > Detach or by using the Detach icon g

You can filter the items by one or multiple column values by
selecting View > Query by Example.

Screen Level Action - Icons and Buttons

The screen level actions display the icons and buttons.

Table 1-3 Screen Level Action - Icons/Buttons and Description

Icons/Buttons

Description

Close window *

Click the * icon to close the window.

Application Help and About Application Links

Use the Help list menu on the top right of the window, to open tabs for Application Help or

About Application.

ORACLE
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Figure 1-26 Application Help Menu

o
2 POAMADMIN v (@ ~

Application Help

About Application

Logging Out of the Application

Chapter 1
Logging Out of the Application

Use the User list menu on the top right of the window, to log out of the application.

Figure 1-27 Logging Out of the Application

L pPoAMADMIN ¥ (@ ~

ORACLE
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Process Orchestration and Monitoring

The Process Orchestration and Monitoring (POM) application is a user interface for
scheduling, tracking and managing batch jobs.

Process Orchestration and Monitoring has the following tabs:

e Batch Monitoring

*  System Configuration

*  Batch Administration

e Scheduler Administration
* Schedule Maintenance

*  AMS Utilities

Batch Monitoring

ORACLE

Batch Monitoring

The Batch Monitoring tab provides a runtime view of the statuses and dependencies with
regard to the different batch cycles for the selected business day.

Select Batch Monitoring in the Navigation Area to open the Batch Monitoring tab.

The application will by default open for a business date where at least one schedule is active.
If none found, it will open for the most recent business date where at least one schedule is
active.

Figure 2-1 Batch Monitoring

Oracle Retail Process Orchestration and Monitoring A rosmsnim v (B v

Business Date sz [ .

r RZIZIW0 & FPAS0ODO | @ AF APPS 2512050

AIF APPS Nightly Schedule Details

Taral Guration: O min
Atrage Duration: O min

Loased [B)
Fun Saart:

AIF APPS Nightly Batch Jobs

Aclors * View * 2 W [A vetscn Show Disabled

Job = Process Name & Status Start Time = End Time < Log & LastUpdate = rhsr:enu
AC_ATTR_MAINT_END._JOB AC_ATTR_MAINT_PROCESS O Loaded D4/ TG GMT+E30 5

AC_ATTR_MAINT_PROCESS 0 Losded 04/31/23 112651 GMT+530

A AT LAARIT DOAERS L T A AT S

Bt Refreste | None w | Lastrefreshect 06/20/28 175841 GMT+530 | Refresh Recaver

2-1



Header

ORACLE

Chapter 2
Batch Monitoring

The header displays information about the batches displayed in the Batch Monitoring
tab. You can also use the header selection to choose which schedule batches to
display.

Figure 2-2 Batch Monitoring Header

R —

Business Date wmmn @ — d—» o =
'y Mo A EASO000 f
5
o
sl | — 3 SaleMode e Schedule Rttt Schedule
6 7

1. Business Date - Displays the business date for the oldest schedules displayed in
Batch Monitoring.

Use this field to select the oldest schedule displayed in Batch Monitoring.

2. Environments - Displays information about each environment integrated with
Process Orchestration and Monitoring.

Select one of these panels to display information about that environment’s batch
processes.

3. Monitoring Cycle - Displays the monitoring cycle of the batches displayed.

Select a monitoring cycle to see the batches scheduled for that cycle. The
following monitoring cycles are available:

*  Nightly
*  Recurring
*  Standalone

4. Environment Status Icon - Click this icon to display a panel at the right side of
the screen showing the status of the Scheduler, Execution Engine and the
environments. The user can also manage the information displayed. See Status
for more information.

5. Activity Feed - Click this icon to display a panel at the right side of the screen
containing activities performed by the system and by the user.

6. Close Schedule - Use this button to close the schedule. This button only appears
for Active schedules.

7. Restart Schedule - Use this button to restart the schedule. This button only
appears for Active schedules.
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Business Date DA/2I3 faR
i moonn RS 2s2m12| & AF APPS 2512080
Schede imgort in Proges
Wightty | Recoing | Standulon o sehechie = [

8. View Upgrades - Use this button to navigate to the Schedule Maintenance screen to

view more details on an upgrade when it is in progress or in error.

9. Download Cycle Summary - Use this button to download a summary for the currently

selected business day for the selected schedule. Once clicked, the Download Cycle
Summary dialog provides the user options to select the cycle and format. This button only
appears for Completed schedules.

Batch Monitoring % Schaeduler Administration

Business Date os/my202s [l

& DFDF 0000 4 DY AIF DATA 251202000 4 RPASCE 2512017 A RPASCETEST 2312.. A TEST 231.201.0

Mo cycles for 21/06/23
Last Schedule Date: 08,/04,/23

Mo eyeles for 21/06/23
Last Schedule Date: 05/03,/24

No eycles for 21/06/23
No Schedule Availabie

Mo eycles for 21/06/23
Last Schedule Date: 01,/06/23

Mo eycles for 21/08/23
Last Schedule Date: 01/06,/23

m Last Schedule instance: 20,/06/23

10

10. Create Schedule - Use this button to create a new Scheduler Day. This button only
appears when a schedule tile is selected for which there is no open Scheduler Day. Click
this button to create a new Scheduler Day for the selected schedule for the business date

following the last schedule instance.

D Safe Mode Reopen Schedule Download Cycle Summary

T

11

@ Confirmation

AIF APPS Schedule has already run and is complete for 2023-06-22. Re-opening will clear the execution history for
2023-06-22 and load fresh schedule instance. Would you like to proceed?

Cancel Ok
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11. Reopen Schedule - Use this button to reopen a closed schedule for the latest

Schedule Tiles

scheduler day. This button only displays for an already completed schedule for the
business day shown. Reopening the schedule will clear the execution history for
that day. A confirmation message is displayed; for example: AIF APPS Schedule
has already run and is complete for 2023-06-22. Re-opening will clear the
execution history for 2023-06-22 and load fresh schedule instance. Would you like
to proceed?

Each schedule tile displays information for a batch schedule that POM is responsible
for running.

Select a tile to display the list of batch processes for that schedule.

Each panel displays the following information:

Figure 2-3 Schedule Tile

ORACLE

2 3 1
@® RPASCETEST 231.2... A RPASCE 23.1.2017 |
Nightly:  Loaded (0/1) 4

Recurring: 1st Disabled (0/0)

Standalone:Loaded (0/11)
No cycles for 22/06/23

Last Schedule Date: 01/06/23

Schedule name and Version - Displays the abbreviation of the application or
application group and the software version. The display schedule name can
alternatively be displayed here instead of the default schedule name. The display
schedule name can be configured on the Schedule tab of the Batch Schedule
spreadsheet.

Run Status - Displays the status of the batch processes:

e Completed (green check mark icon)

*  Active (green target icon)

e Error (red X icon)

*  No activity (amber triangle icon)

e Suspended (pause icon)

e Safe mode (Amber circle icon with a warning icon inside of it)
*  Patch Mode (Amber circle icon with a warning icon inside of it)

Monitoring Cycles and Statuses - Displays the number of completed and total
jobs for a nightly / recurring cycle and the number of completed and total ad hoc
flows / processes for a standalone cycle.
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4. Last Schedule Date - Indicates the last date on which the batch processes were
configured.
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< Note:

e A green tile with a green target icon in the top left indicates that the
schedule is in progress.

e A green tile with a green checkmark icon in the top left indicates that the
schedule has completed.

e Arred tile with a red cloud icon indicates that a new schedule version
upgrade has failed. Navigate to the Schedule Maintenance screen by
clicking on the View Upgrades button to address the failure.

* A blue spinner icon in the top left of the tile (2) indicates that the
schedule is in the process of being upgraded to a new version. The user
can navigate to the Schedule Maintenance screen by clicking on the
View Upgrades button to check the progress of the upgrade.

When a schedule is being upgraded or when the schedule upgrade has
failed, the user is prevented from most activities on the Batch Monitoring
and on the Batch Administration screen.

Some features are disabled while a schedule is being upgraded

| ) Some features are dizabled while a schedule is being imported |

| ﬂl Some features are dizabled while 2 schedule iz in 2 failed state

* An amber warning circle icon in the top left of the tile (2) indicates that
the schedule is set to run in safe mode. This means that the batch
schedule will simulate a complete run but without the jobs actually
executing on the application server. Aside from the amber warning circle
icon displayed in the top left of the tile, an amber ‘Safe Mode’ message
is displayed in the area right below the tile area.

Safe Mode

e An amber warning circle icon in the top left of the tile also indicates that
patching is currently in progress and run executions will be paused until
the patching completes. Aside from the amber warning circle icon
displayed in the top left of the tile, an amber ‘Patch Mode’ message is
displayed in the area right below the tile area.

Patch Mode

«  An amber tile indicates that there is no instance of the schedule for the
selected business date.
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The batch jobs header displays the following information:

Figure 2-4 Batch Jobs Header

Mightly | Recuring | Standaion Sate Mode

Test-Merch Nightly Schedule Details

Batch Monitoring

|
. W Ermox (5
B Completed (%5}

Tetal Duspsicn: O mis
Average Duratioe: O rin

B
bE

Louden (81} Foun Seant: GB/25/25 0330005 GMIT 530

Recurring  Standabies

AIF Nightly Schedule Details

£
. W Compleied {MAZ)
Fun Ert

Run Start:
03/21/23 20:03:49
GMT+5:30

03/21/23 20:36:00
GMT+5:30

Run Status Chart

The run status chart shows a chart summary of the status of the different batches (including
the number of batch jobs with that status) that are included in the selected cycle for the
selected schedule. The possible statuses are:

ORACLE

Loaded - Jobs are in loaded state when the scheduler day is first created.

Pending - Job is waiting to run.

Completed - Job ran successfully on the system.

Error - A failure occurred due to an issue in the environment or the job's application.
Held - An administrator placed the job on hold.

Skipped - An administrator has skipped the running of the job so the remaining jobs in the
cycle can proceed.

Running - Job is currently running on the system.

Long Running - The job's run time has exceeded a threshold. If a Threshold Run Time is
specified for the job on the Edit Job popup of the Batch Administration screen, then a job
is deemed long running if its current run time exceeds that value. Otherwise, if a
Threshold Run Time is not specified, then the job is deemed long running when its
current run time exceeds the Long Run Average Time Multiplier (specified on the Edit
Settings popup of the System Configuration screen) times the average run time of that
job. For example, if a job's average run time is 3 minutes, and the Long Run Average
Time Multiplier is 3, then the job is considered long running if it has been running for at
least 9 minutes. A notification is sent when a job is deemed long running.

Disabled - Job was disabled by an administrator on the Batch Administration screen.
System Held - Job was placed on hold by the system due to a lack of resources to run it.

Skipped on Error - Job was preconfigured to be skipped on a failure.
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*  Waiting - Job is waiting for completion of pre-dependencies (Hourly Cycle, Nightly
Cycle, External Dependency and Inter-Schedule Predecessor Jobs).

Completed Batch Job Statistics

< Note:

Completed Batch Job Statistics are displayed only for Nightly and Recurring
cycles.

For completed batch jobs, the batch job header shows the following information:
* Run Start

*  RunEnd

* Total Duration

* Average Duration

Active Batch Job Statistics

# Note:

Active Batch Job Statistics are not yet implemented. They will be
implemented in a future version of POM.

For active batch jobs, the batch job header shows the following information:

e Estimated Completion Time
e Estimated Time Remaining
» Total Duration

e Average Duration

¢ Run Start

Batch Information

ORACLE

The batch information area displays the following information about the batch process
results:

Execution Requests - Displays the number of completed executions and the total
number of execution requests. Click to open the Execution Requests Window.

Agent Job Requests - Displays the number of completed and total number of Agent
job requests. Click to open the Agent Job Requests Window for the schedule and
cycle selected.

Scheduler Tasks - Displays all tasks scheduled to run during the current scheduler
day. Click to open the Scheduler Tasks window.
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External Dependencies - Displays the number of successful and total number of external
dependencies. Click to open the Batch Cycle Details Screen.

Inter-Schedule Dependencies - Displays the number of successful and total number of
inter-schedule dependencies. Click to open the Batch Cycle Details Screen.

Callbacks - Displays the number of successful and total number of callbacks. Click to open
the Batch Cycle Details Screen.

Schedule Links - Displays the number of successful and total number of schedule links.
Click to open the Batch Cycle Details Screen.

Execution Requests Window

The Execution Requests window displays information about execution requests for a batch.

Click Done or the close window icon * to close the window.

Figure 2-5 Execution Requests Window

amnbentang: —

Execution Requests for AIF Nightly X
Execution Requests

Actions T View ¥ 2 W [ pesn

IEB'“’“‘““" : Status S Request Type = Cyde = Flow & :;Edm z ;:;I % ompleted  Pending

40 % Complesed SCHEDULER_ RECREST Hightly Hightly w0 s a5 o

Execution ID 1140 Details

Actions T View ¥ 2 YV [ oamn

Jok

:.m s Status = Job Hame = Process * Log = :::::.nlunlo s Last Update ;:;‘
Wb & Completed ROE_EXTRACT_DiM_P3_PROCLRSDE_J08 ROE_EXTRACT_DIM_PS_PROCLASOE PROCESS .- a0 O/21/E3 20048 GMT 530

W @ Completed RDE_EXTRACT_DiM_PS_PROMIERSOE_JOB ROE_EXTRACT_DIM_PS_PROMERSOE_PROUESS # it O/1/ES MO0 GMT #5350
s & Completed EOE_EXTRACT_DIM_PS_PRDITMATTRIOE_JOB ROE_EXTRACT_DIM_PS_PRINTMATTRSOE_PROCESS. L) L] ON/TYII 2006 GMT +E30

WSt & Completed FOE_EXTRACT_DIM_PS_PROTMOELSOE_JOB ROE_EXTRACT_DiM_RS_PRONTMDELSDE_PROCESS & 006 OS/21/23 20064 GMT 4580
WAL % Completed FOE_EXTRACT_CIM_PS_PEDITMOIM_IOB ROE_EXTRACT_DIM_PS_PRINTMENM_PROCESS. L1 08 O/ Moot GMT 450
WZPOBG & Compieted RDE_EXTRACT_DIM_PS_PRINTMMGSDE_JOR )

Execution Requests

FOE_EXTRAL

T_DIM_PS_PRONTMIMGSDE_PROCESS

O/2Z5 200000 T5 GMT #5350

This section displays the following information about each execution request in the batch
process:

ORACLE

Execution ID
Status
Request Type
Cycle

Flow
Scheduler Day
Total Jobs
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e Completed

* Pending
e Skipped
* Failed

e System Held
e Submitting
e Submitted

See Table Menu Options in the Common User Interface Controls for information about
the options available for this section.

Execution Details

This section displays the following information about each job run by the execution

request:
e JobRunID
e Status

e Job Name

*  Process Name

* Log— Download log in text file format.
* Job Execution ID

e Last Update

* First Job

e Error Info

See Table Menu Options in the Common User Interface Controls for information about
the options available in this section.

Agent Job Requests Window

The Agent Job Requests window displays information about batch requests submitted
to the POM Agent. The agent is the component of POM usually deployed on the
application server where the batch jobs actually execute.

Click Done or the close window icon () to close the window.
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Figure 2-6 Agent Job Requests Window

AIF Nightly Agent Job Requests ®
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@ Completed 400 EXEC S_W_EXCH_RATE_G5_J08 STAGING SI_W_EXCH_RATE Paylosd riabatchclent-. L] QLIS IOB0 0N
@ Complated 0408 L] W_RTL_SUPPLIER_TRAIT_ DS STG_JO& STO_W_RTL_SUPPLIER_TRAL Purioad riabatehliont- L] 02123 P08 G
& Completed 405 L STG_ S PRODUCT_J08 STG_SI_PRODUCT_PROCESS ribatchcient-. L] O3 D108 G
& Complwted 0407 L W_RTL_NVRECLASS IT_LC DY _FS_STG_J, STG_W_RTL_INVRECLASS IT_, rabatctient-. L] Q32073 J0H08 G

Done

Agent Job Requests

This section displays the following information about each Agent job request in the batch
process:

ORACLE

Status - Possible values are Complete, Running, Error, and Loaded
Request ID - Agent request ID

Type - Possible values are EXEC (shell script based job) or RI/RASE/RDS/
RPAS/BDI/OB/OMS which are all values for service based jobs

Job - job name

Process - Process name

Payload - Service payload in case the type corresponds to a service based job
Info - Error Information in case the request is in Error status

Agent Id - The identifier of the Agent which Initiates the job execution request
Application Name

Create Date

Start Time

End Time

Last Update Time

Execution Request Id

Job Run Id

See Table Menu Options in the Common User Interface Controls for information about the
options available in this section.
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Scheduler Tasks

The Scheduler Tasks window displays information about tasks that are scheduled to

run during the current scheduler day. See the Scheduler Administration section of this
chapter.

When the new scheduler day is created every day (at the end of the Nightly batch run),
it creates the scheduler tasks according to the way they are set up in the Scheduler
Administration screen.

Figure 2-7 Nightly Scheduler Task Window

AIF Nightly Scheduler Task x

AlF Nightly Scheduler Task

Actiors W View * 2 ¥V B pewen

Task . - - Schedule . Schedule . - -

Id % Enabled Status % Flow Name = Date * Time % Next Runin = Time Zone =

w07 s Enabled Mgty oy R {UTC+05:30) Calcunta - India Standard Tiene

Task ID 93807 Executions

Acons v View = 2 ¥ [ oetacn
I‘-“""‘D 00 < Stans = Start Time = tnfo =
nag Complened /0523 2003 15T

Time: D&/7725,04304BUTC  Dane

Figure 2-8 Recurring Scheduler Tasks Window

Basiteshore: —

AIF APPS Hourly_Cycle_15cheduler Tasks x

AIF APPS Hourly_Cycle_1 Scheduler Tasks

Betiers ¥ View ¥ & ¥ B vese

Task 2 - Schedule . Schedule . = . 2

™ % Enabled Status T Flow Name = Date * Time % NextRunin = Time Zone =

2] os  Compleced AS0_INTRADAY_CYCLE mosas 0T [T +05:30) Calcurma - Incha Stanclard Time

Task ID 172151 Executions

Artees ¥ View v & |V [ etach
IE;““““" < status ¢ Start Time 2 Info =
505 Completed 200823 2T IST

Time: 08/FU75 0SILATUTE | Do

Click Done or the close window icon () to close the window.
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The Scheduler Tasks window for the Nightly and Recurring cycles display the same task
attributes listed below. The difference is that there is only one Nightly task for a scheduler day
whereas there could be multiple Recurring flows running throughout the day.

Nightly/Recurring Scheduler Tasks

This section displays the following information about each Nightly/Recurring Scheduler task:

Task ID
Enabled - Switch to enable or disable the execution of the task

Status - Possible values are: Enabled, Disabled, Completed, Skipped On Delay,
Scheduled, Error, or Cancelled

Flow Name - Nightly or recurring flow name
Schedule Date
Schedule Time

Time Zone

" Note:

When the New Scheduler Day is created, if the start time for a certain task has
elapsed, the task will be scheduled for the next day. The Next Schedule Run
column will show the next time the task will execute.

See Table Menu Options in Common User Interface Controls for information about the
options available for this section.

Task Executions

ORACLE

This section displays the following information about each task executions:

Status - Possible values are: Completed, Error
Start Time

Info - If the Status is Error, this field changes to a link which, when clicked, will open a
dialog showing error details.

See Table Menu Options in Common User Interface Controls for information about the
options available in this section.

The user can edit the Nightly or Recurring tasks to change the time they run for the day.
Permanent changes need to be entered in the Scheduler Administration screen.

< Note:

If the user makes a change to the time, he or she needs to click the Run action to
schedule the task.

It is alternatively possible for the user to circumvent the steps mentioned above and
click on Run Now if they intend to schedule the task for immediate execution.
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When Run or Run Now is clicked, confirmation windows are displayed based on the
time zone and current business date.

Figure 2-9 The scheduled time in the given time zone is past the current date

@ Confirmation

You are about to start the Nightly task for business date (20/06/2023) at 7:18 PM on 12/06/23 (US/Hawaii) and it
impacts the next day's nightly cycle schedule, since Rl has ‘One Nightly Cycle Per Calendar Day’ rule enabled. Would
you like you continue?

Comment

P]ease add comments |

Required

Please note that scheduled start time (12/06,/2023, 6:00 PM) of the next business day's (21/06/2023) nightly cycle also
has passed, hence it would be scheduled to run on 13/06/23, 6:00 PM (US/Hawaii)

‘ Cancel | Ok ‘

Figure 2-10 The scheduled time in the given time zone has not passed the
current date

@ Confirmation

You are about to start the Nightly task for business date (20/06/2023) at 7:16 PM on 12/06/23 (US/Hawaii) and it
impacts the next day's nightly cycle schedule, since Rl has 'One Nightly Cycle Per Calendar Day' rule enabled. Would
you like you continue?

Would you prefer to,
(® Honour the rule and move next business day's (21/06/2023) nightly to the next calendar day, which is 10:00
PM on 13/06,/23 (US/Hawaii)

(O Override the above rule and keep the next business day's (21/06/2023) nightly as per the original schedule, which
is 10:00 PM on 12/06,/23 (US/Hawaii)

Comment Please add comments ‘

Required

Cancel ‘ Ok ‘

Also, for the task to be editable, it must be in a state other than Scheduled. If itis in a
Scheduled state, the user can click the stop action, which puts the task in a Cancelled
state, and it will then be editable.

ORACLE"

2-14



Chapter 2
Batch Monitoring

Edit Task Nightly
Enabled [ )
Schedule Date | 06/29
Schedule Time | 12:00 PM (UTC+05:30) Calcutta - India Standard Time v
Cancel 0Ok

Standalone Scheduler Tasks

Figure 2-11 Standalone Scheduler Tasks Window

—— ]

Test-Merch Adhoc Scheduler Tasks ®

Test-Merch Adhoc Scheduler Tasks

des v Vew v 0 |V 2 o
Task - - a - - Liemit =~ Prevent start a Schedule . Schedde . 5
W F Enabked  Status ® Name ¢ Thpe 3 Description Frequency = s *  mtavelehtly ¥ 3 F T € & NemtRunin @
oz B e Coms Cn_HALE DATA,PROCESS,_ A o o P —
Ly [ R -— onr A_BUDGET PROCEESA..  Proc e s )
et W o O TEM NP PROCERS ADHGS Precess Srge nevs mw
[ W v Cosaled CENN_ARC_PURGE STNS PROCESS AD..  Praess ey § A - BRI s
P W s Coanoeled OV, PO_RECERVE, PROCESS_ADHOC Process. Ervery 30 ety 7 a0 ad
oana B v Comcieies COMY_SL_PT_ROCESS_ADHOC Procen g FECT T )

' K

»

B -

B

-
Task ID 98862 Executions
Mas T Vew T = ¥V 2 oms
Touon ; Suus = Start Time Info
e tomgieted Oy usaET

Teme: Q&yTHIL, CESAATUTC Dore:

Click Done or the close window icon (*) to close the window.

Standalone Scheduler Tasks

ORACLE

This section displays the following information about each Standalone Scheduler task:
Task ID
Enabled — Switch to enable or disable the execution of the task.

Status — Possible values are: Enabled, Disabled, Completed, Skipped On Delay, Scheduled,
Error, Cancelled.

Name — Indicates Process / Flow name

Type — Indicates whether it is Process or Flow
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Description — Provides a description of the task
Frequency — Single or Every x minutes.

Limit Occurrences —If this field has a value, the process will run every x minutes for y
occurrences.

Prevent Start During Nightly — Indicates that the process should not start running
when Nightly is in progress. If the process starts running before Nightly start, it will
continue running even if the run extends into the Nightly run.

Schedule Date

Schedule Time

Next Run In — Displays the time remaining until the next run.
Time Zone

Click Done or the close window icon () to close the window.

See Table Menu Options in Common User Interface Controls for information about the
options available in this section.

The user can edit a Standalone task to change any of the fields in the window below.
Edits are effective just for the day's run. Permanent changes must be entered in the
Scheduler Administration screen.

Edit Task CONV_PO_SHIP_PROCESS_ADHOC
Enabled I_;.

Description Run CONV_PO_SHIP_PROCESS_ARHOQC once

Frequency @ Single -
Schedule Date | /2023

Schedule Time = 12:00 AM (UTC+05:30) Kolkata -

Prevent start during nightly (Il

Cancel Ok
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Edit Task CONV_PO_SHIP_PROCESS_ADHOC
Enabled [

Run CONV_PO_SHIP_PROCESS_ADHOC every 15
minutes.

Description
Frequency = Minut ¥ 15
Limit occurrences | 2

Schedule Date | /2023

Schedule Time = 12:00 AM {UTC+05:30) Kolkata -

Prevent start during nightly :-

Cancel Ok

< Note:

If the time is left blank for a standalone task, it will execute immediately upon
clicking Ok.

When the New Scheduler Day is created, if the start time for a certain task has
elapsed, the task will be scheduled for the next day. The Next Schedule Run
column will show the next time the task will execute.

Task Executions

This section displays the following information about each task execution:

*  Execution ID
e Status - Possible values are: Completed, Error
e Start Time

e Info - If the Status is Error, this field changes to a link which, when clicked, will open a
dialog showing the error detalils.

See Table Menu Options in Common User Interface Controls for information about the
options available in this section.
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Batch Cycle Details Screen

Batch Monsarng. ¥

Batch Cycle Details =
EPASCETEST Mightly

Average Durstiors Oimin

External Dependencies

Srtan Souree Jeb Targen Jots
) Perctrg A1 BATEM_ALE D 300 TR TESTRG Diuatie

Inter-Schedule Dependencies

..... Source b Target 1t Tages Process g Sehacule

OT_EPOAT_PROCESS L Eratie

PO EIPOAT_POCESS Ll Fratie

) Dastied NATE SOST_BATA P START_Jo8 S FEST_PNT_08 e AT _DPORT_PROCELS o Erable

The Batch Cycle Details screen displays the following sections:

Header

The header displays the following information about the batch cycle:

* Run Status Chart

Completed Batch Job Statistics
Completed Batch Job Statistics
For completed batch jobs, the batch job header shows the following information:

« Run Start
e  RunEnd
e Total Duration

* Average Duration

Active Batch Job Statistics

For active batch jobs, the batch job header shows the following information:

" Note:

Active Batch Job Statistics are not yet implemented. They will be
implemented in a future version of POM.
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» Estimated Completion Time
» Estimated Time Remaining
* Total Duration

e Average Duration

 Run Start

External Dependencies

External Dependencies

Status Source Job Target Job

Pending AP_BATCH_AGG_D_JOB EXTERNAL_TESTING Disable

The External Dependencies section lists all the external batch job dependencies for the entire
current Schedule. These dependencies are only shown if the system level external
dependencies indicator is turned on. An external dependency is usually a dependency on a
customer's internal process. This dependency is released once the customer calls an
endpoint into POM for a specific POM job.

The following information is displayed for each external dependency:

e Status

e Source Job - Click to open the job in the Batch Job Details screen. The source job is a
job in the current schedule which is dependent on the external (target) job.

* Target Job - The job that, when complete, will release the dependency which the source
job is waiting on.

Inter-Schedule Dependencies

ORACLE

Inter-Schedule Dependencies

Stans Sowrre Job Targes 1o Tariget Process Targen Schachie

Pening AP BATCH_AGE b8 w30 AGGRECATION_LTRITY_ADHGE - e
[ AP T BATA i START_SR Tl S6F_Boi_n_iod AL_CLUSTER SET_choRT_Mocids i Enatle

Dinsied AP_POST_DATA P START_IG8 D7 EBF0RT_EMD_100 DT_DMPORT, PROCESS = Ensie

The Inter-Schedule Dependencies section lists all the inter-schedule batch job dependencies
for the entire current Schedule. These dependencies are only show if the system level inter-
schedule dependencies indicator is turned on. An inter-schedule dependency links the
current schedule and a target schedule where a job in the target schedule is dependent on
the completion of a job in the current schedule.

The following information is displayed for each inter-schedule dependency:

» Status
e Source Job - Click to open the job in the Batch Job Details screen.

* Target Job - Click to open the job in the Batch Job Details screen. Target job is
dependent on the source job.
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Target Process - Process containing the target job.
Target Schedule - Schedule containing the target process/job.

A Disable/Enable button to disable or enable the dependency.

Schedule Links

A Schedule Link links the current schedule and a target schedule where the current
schedule does not start until the completion of a job in the target schedule.

The following information is displayed for each schedule link:

Status

Source Job - Click to open the job in the Batch Job Details screen. The job in the
current schedule which starts the current batch when the Target Job completes.

Target Job - Click to open the job in the Batch Job Details screen. The job in the
Target Schedule which when completes fulfills the dependency for the Source Job
in the current schedule.

Target Process - The process which the Target job belongs to. - The schedule
whose job is a dependency for the job in the current schedule.

Info - Shows information regarding error if failed or skipped.
Target Schedule

If it was not successful, a Retry button to retry the schedule link.

Callbacks

W_INT_ORG_DH_RTL_TMP_JOB OAD_DIM_INITIAL_ADHOC baylozd o Retry

W_RTL_ORG_RECLASS_TMP_JOB OAD_DIM_INITIAL_ADHOC Paylcad Ve Retry

The Callbacks section lists all the external status update request and response
callbacks based on the External Status Update mode set in the External System
Configuration screen.

The following information is displayed for each callback:

Status
Job - Click to open the job in the Batch Job Details screen.
Process - Process containing the job.

Date of callback
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A Payload link to display the Callback - Payload Window for the callback.

An Info link to display the Callback - Info Window describing the callback response.

If the callback was not successful, a Retry button to retry the callback.

Nightly and Recurring Batch Jobs

ORACLE

AIF APPS Nightly Batch Jobs

View ¥ 2 V| pewen Shiw Diiabled

Vg
Log © LastUpdate = Historical ©  Parameter Duration ©
Run Time

AC_ATTR_MAINT PROCESS & Completed DAY 2S TEWIAS GMT+5.30 5 ALATTR.. EXEC & Complesed

Start . End .
Time ~ Time ~

Job

S ProcessStatus =
Type

Process Mame = Status ©
AC_ATTR_MAINT_PROCESS & Completed DOTYZS TENEAS GMT+530 AC_ATTR_... EXEC & Complened
AC_ATTR_MAINT_PROCESS () Completed DTS THEAS GMT+530 EXEC & Corrplened

AC_ATTR_MAINT_PROCESS &) Completed 04/TY23 N045 G

AT+530

3
5
5 EXEC & Corpheaed
o

| ACATTH_MAINT_PROCESS & Completed /T TEHRAS GMT 530 EXEC & Comglesed
AC_ATTH_MAINT_PROCESS (%) Completed DO/ZTLS WA GMT+550 5 EXEC & Complesed
AC_ATTR_MAINT_PROCESS (5 Camplesed 06/ZT25 INDAS GMT+530 5 EXEC & Comglesed

AC_ATTR_MAINT_PROCESS {5 Completed D4/FYII TEHAS GMT+5:30 5 ENEC & Ceerplened

The Batch Jobs section lists all the batch jobs for the selected schedule and the selected
cycle — Nightly or Recurring. The table displays the following information:

Status

Loaded - Jobs are in loaded state when the scheduler day is first created.

Pending - Job is waiting to run.

Completed - Job ran successfully on the system.

Error - A failure occurred due to an issue in the environment or the job's application.
Held - An administrator placed the job on hold.

Skipped - An administrator has skipped the running of the job so the remaining jobs
in the cycle can proceed.

Running - Job is currently running on the system.

Long Running - The job's run time has exceeded a threshold. If a Threshold Run
Time is specified for the job on the Edit Job popup of the Batch Administration
screen, then a job is deemed long running if its current run time exceeds that value.
Otherwise, if a Threshold Run Time is not specified, then the job is deemed long
running when its current run time exceeds the Long Run Average Time Multiplier
(specified on the Edit Settings popup of the System Configuration screen) times the
average run time of that job. For example, if a job's average run time is 3 minutes,
and the Long Run Average Time Multiplier is 3, then the job is considered long
running if it has been running for at least 9 minutes. A notification is sent when a job
is deemed long running.

Disabled - Job was disabled by an administrator on the Batch Administration screen.

System Held - Job was placed on hold by the system due to a lack of resources to
run it.

Skipped on Error - Job was preconfigured to be skipped on a failure.

Waiting - Job is waiting for completion of pre-dependencies (Hourly Cycle, Nightly
Cycle, External Dependency and Inter-Schedule Predecessor Jobs).
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» Job - Click to open the job in the Batch Job Details screen.
e Application

e Last Update

» Parameter

» Job Type - Depending on the value, determines if a job is service based or shell
script based.

e Process Name
*  Process Status

* Log - When the job is in error, this field will display a down-arrow icon which when
clicked will display the content of the log.

» Job Description

e Start Time
e End Time
e Duration

* Average Run Time

* Average Historical Run Time
*  Number of Runs

»  Error Source

*  Waiting

*  Waiting Reasons

Action Menu and Icons

ORACLE

See Action Menu and Icons for common actions that can be performed through the
Action menu and the icons. You can also perform the following actions:

Table 2-1 Batch Jobs - Actions Menul/lcons and Description

_______________________________________________________________________|
Actions Menullcons Description

Show Disabled Use the Actions > Show Disabled or Show Disabled. By
Default, the table won’t show any jobs with Disabled Status.
Use Show Disabled button or action to see the list of
Disabled job.

Hold Use the Actions > Hold or the Hold button to put the
process on hold.

Skip Use the Actions > Skip or the Skip button to skip the
process.

Run Use the Actions > Run or the Run button to run the process
immediately.

Rerun Use the Actions > Rerun or the Rerun button to run the job
again.

2-22



Chapter 2
Batch Monitoring

Table 2-1 (Cont.) Batch Jobs - Actions Menul/lcons and Description

Actions Menullcons

Description

Kill

Edit Parameters

Use the Action>Kill or the Kill button to stop the execution
of the job.

The job needs to be running for this action to be enabled.
When the Kill command is enacted on the screen one of two
confirmation messages opens depending on whether a
cleanup script is associated with the job being killed.

If a cleanup script is associated with the job, the
confirmation message presented is “a cleanup will be
performed after this job is terminated. It is advisable to wait
a few minutes after termination before proceeding with the
remaining batch schedule” This is because it may take a
minute or so for the cleanup to complete.

If a cleanup script is not associated with the job, the user is
cautioned to make sure he or she is sure about proceeding
without a cleanup script.

That maybe be acceptable, as not all jobs require cleanup
when terminated. The confirmation message in this case is
“there is no post termination cleanup script associated with
this job. the job will be terminated but not post cleanup will
be performed. This may or may not be ok for this job. Check
with Oracle Support if this is a concern.

Use the Actions > Edit Parameters or the Edit Parameters
button to edit the parameters for the job. The new
parameters are only effective for the current day's batch
run.

View Menu

See View Menu for information about the options in the View menu.

Status Detalls for Job

Certain status values on the Batch Jobs section such as 'Error' or 'Long Running' act as a
link. When clicked a popup is displayed containing more details about why the job is in the
given status and helpful suggestions for resolving the issue. An example is shown below for a

job in error.

ORACLE
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Details on Error Job ALLOCBT_JOB

Reason
Possible Resolution

Error Info

This Job has failed during execution at the Agent.
Please reach out to the Oracle support team, for further investigation.

Moving the Job 3865 to ERROR status since Agent pomgent-deployment-b744f88f8-71bx9_0850M
is found to be inactive / shutdown

Y
Job Execution ID 3865 Execution Request ID Nn74
Start Time 03/25/23 10:49:30 GMT+5:30 Execution Request Status ERROR
End Time 03/25/23 12:14:57 GMT+5:30
Last Updated 03/25/2312:14:57 GMT+5:30
Download Log Cancel Ok

Standalone Batch Jobs

The standalone cycle includes the following information for each flow, process and job:

Figure 2-12 Standalone Batch Sections

o e —

Business Date

. AF DATA LA | A&

AIF DATA Standalone Entities

S Dinatied

E_INV_RELOAD_PROCESS_ ADHOL
& e
=

Custom_CFLOW
O toacea

Left Pane of the Screen

ORACLE

e SearchbyN

wom @ & m

RS HLNLE A AF LS 13000

Cumaiehodule  Restiet Schadle

E_INV_RELOAD_PROCESS_ADHOC Batch Jobs
Atioes w Vew = 2 ¥V 2o Shm Drabled
b o Process Hame Status Start Time End Time = Log ©  LastUpdste

WAL

E_Y_RELOAL PIOCESS AROC [<TL OO MDCM NN OO MO GMTHE OO

W_RTL

P SELOAD, PSS AT © o cers s

ame or Status - Search for an invokable by entering a search term

and clicking Enter. An invokable can be a flow or a process that does not belong

to a flow.

also listed on

Show Disabled - When this switch is enabled, disabled processes and flows are

the left panel.

Flows/Processes - The following information is shown for each flow/process:

—  Flow/Process Name
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* Loaded - A flow or process is in a Loaded state when the scheduler day is first

created.

*  Completed - A flow or process that ran successfully on the system.

*  Error - A failure of a flow or process occurred due to an issue in the environment
or the job's application.

*  Cancelled - A flow or process in a Loaded status is marked as Cancelled when
the scheduler day is closed.

— Flow/Process Label

Run Icon - Click on the play button to run the adhoc flow/process. It is available only
when the status of the flow/process is in a Loaded or Completed status.

Right Pane of the Screen

Click a row in the left panel of the Standalone Entities table to refresh the Batch Jobs table,
list the jobs for the selected standalone flow/process, and display information similar to what
is listed in the Nightly and Recurring Batch Jobs section above.

Action Menu and Icons

ORACLE

See Table Menu Options in Common User Interface Controls for information about the
options available in this section. You can also perform the following actions:

Actions Menullcons

Description

Show Disabled

Run

Skip

Use the Actions > Show Disabled or Show Disabled. By Default,
the table won’t show any jobs with Disabled Status. Use Show
Disabled button or action to see the list of Disabled jobs.

Use the Actions > Run or the Run button to immediately run the
individual job of the process or flow.

Use the Actions > Skip or the Skip button to skip the batch job
immediately. Based on the status of the job (Loaded or Error), a
warning pop up opens if the job needs to be skipped for the
current failed execution or for the immediate next execution or
for all job executions on the current business date.
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Figure 2-13 Skip Warning - Job is in ‘Loaded’ or ‘Completed’ status

Skip A3_ADHOC_JOB2

(Y Warning
Skipping a job may result in data corruption. You are required to enter a detailed reason for
this action.

Would you like to skip this job

@ for just the immediate next execution of the job ?

QO for all the job executions on the current business date ?

Comments ) ) ) ) )
Enter a reason for this action that is at least fifteen non-repeating

characters for audit purposes.

Required

‘ Cancel ‘ Skip ‘

Figure 2-14 Skip Warning - Job is in ‘Error’ status

Skip W_RTL_INV_IT_LC_DY_F_JOB

% Warning
Skipping a job may result in data corruption. You are required to enter a detailed reason for
this action.

Would you like to skip this job
(® for just the current failed execution of the job ?

(O for all the job executions on the current business date ?

Comments . . ) ) )
Enter a reason for this action that is at least fifteen non-repeating

characters for audit purposes.

Required

‘ Cancel H Skip
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Standalone Execution Details

ORACLE

Figure 2-15 Standalone Executions
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Clicking on a flow/process link from the left panel of the Standalone Entities table opens a
new modal window displaying the Batch Execution details. The following information is
displayed about each execution.

*  Status
— Loaded — Jobs are in loaded state when the scheduler day is first created.
— Completed — Job ran successfully on the system.
— Error — A failure occurred due to an issue in the environment or the job’s application.

— Cancelled — Flow which are in Loaded status, are marked cancelled when the
scheduler day is closed.

e Execution ID

* Process Exec ID
e Start Time

e« EndTime
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Figure 2-16 Standalone Execution Detail
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The following information about the jobs executed for each Execution ID is displayed

when an Execution row is selected.

Status

— Loaded - Jobs are in loaded state when the scheduler day is first created.

— Disabled - Job is in disabled state.

— Completed - Job ran successfully on the system.

— Skipped - Job is in skipped.

— Skipped_On_Error - Job is in skipped when it throws an error

—  Error - A failure occurred due to an issue in the environment or the job's

application.

— Held - Job is in held state.

Job — Name of the job

Process — Name of the process

Job Exec ID
Job Run ID
Start Time
End Time

Clicking on the job link (for example, VARIABLE REFRESH JOB) from the Execution
Details table opens the Batch Job details in a new modal window and provides
detailed information about a batch job

Batch Job Details

The Batch Job Details screen provides detailed information about a batch job.

Depending upon the status of the job, one or more of the following buttons will be
available at the top of the screen:

ORACLE
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« Hold

* Run - This is available only for Standalone jobs.

* Release

* Release Skip
* Rerun

«  Skip

Figure 2-17 Batch Job Details
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Batch Job Details

Job W_MCAL_PERIOD_DS_STG_I08

G dob Suetes: Comvplened

Execution Requests

Executions.
Pre Dependencies

Saan do Protess

& Completed WAL AL PRS0 O COPY_S0N DIVTIST LPROiSs
Post Dependencies

2an = Proce

%) Completed Ol CALEWGWR VALIDATOR: 308 DEVTEST CPROCESS.
External Dependencies -

Inter-Schedule Dependencies
Schedule Links

Callbacks

Figure 2-18 Batch Job Details with Status Information
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Execution Requests

Executions

ORACLE

Status Execution|D  Job Run Id Request Time Log

Q Error 601 2550915 06/26/23 20:07:33 GMT+5:30 4 Error Info

Execution Requests

Status ExecutionlD  Job Runid Request Time Log

& Completed 51 2073840 06/06/23 143329 GMT+5:30 +

If the job was executed, this section displays the following information about the job
execution:

» Status

» Execution ID

* Request Time

* Log - Provides a link to download the execution log

e Error Info - This will only show in case of an error status

Executions
Salus [ & Jobs Ruars 1D Saadt Tirme End Tirrsi Leg
) Cormplated i ITRAED OIS OS] GMT+ 550 OIS O DT5S GRT #5300 4

If the job was executed, this section displays the following information about the job
execution:

e  Status
« ID
e JobRunID

e Start Time
e End Time

e Log - Provides a link to download the execution log.
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Pre Dependencies

Pre Dependencies

Status Job Process

& Completed RI_IW_CUSTOM_9_JOB RI_IW_CUSTOM_PROCESS

This section displays the following information about job pre-dependencies:

» Status
» Job - Click to open the job in the Batch Job Details screen.
*  Process

» A Disable/Enable button is available for jobs that have not yet completed.

Post Dependencies

Post Dependencies

Status Job Process

& Completed RI_IW_CUSTOM_END_JOB RI_IW_CUSTOM_PROCESS

This section displays the following information about job post-dependencies:

e Status
* Job - Click to open the job in the Batch Job Details screen.
*  Process

* A Disable/lEnable button is available for jobs that have not yet completed.

External Dependencies

External Dependencies

Status Source Job Target Job

Skipped AP_BATCH_AGG_D_JOB EXTERNAL_TESTING

An external dependency is usually a dependency on a customer's internal process. This
dependency is released once the customer calls an endpoint into POM for a specific POM
job. This section displays the following information about job external dependencies:
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e  Status

* Job - Click to open the job in the Batch Job Details screen. The job that, when
complete, will release the dependency which the currently displayed job is waiting
on.

* A Disable/lEnable button is available for jobs that have not yet completed.

Inter-Schedule Dependencies

Inter-Schedule Dependencies
Seatery. Souce Job Tacget Job Target Proceis. Target Shuchule
Shipged

AGOREGATION,_LITLITY_ADHOC

Disatsied STER_SET_EXPORT_PROCESS

Disatsied OT_DPORT_PROCESS

An inter-schedule dependency links the current schedule and a target schedule where
a job in the target schedule is dependent on the completion of the currently displayed
job in the current schedule. This section displays the following information about job
inter-schedule dependencies:

e Status

e Job - Click to open the job in the Batch Job Details screen. Job which is
dependent on the source job.

e Process - Process containing the job.
e Schedule - Schedule containing the process/job.

A Disable/Enable button is available for jobs that have not yet completed.

Schedule Links

ORACLE

Schedule Links

This section displays the following information about schedule links for a job:

e Status

e Job - Click to open the job in the Batch Job Details screen. The job in the Target
Schedule that., when completed, will fulfill the dependency for the currently
displayed schedule.

e Process - The process the job belongs to.

e Schedule - The schedule whose job is a dependency for the job in the current
schedule.

» Info - Shows information regarding error if failed or skipped.
* A Disable/lEnable button is available for jobs that have not yet completed.

e A Retry button is available for schedule links with a Skipped or Failed status.
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Callbacks

Callbacks

Sy Job Process Date Payload Info

€ Failed W_INT_ORG_DH_RTL_TMP_IOB LOAD_DIM_INITIAL_ADHOC Payload nfo Retry

This section displays the external status update request and response callbacks based on
the External Status Update mode set in the External System Configuration screen. This
section displays the following information about job callbacks:

e Status

* Job - Click to open the job in the Batch Job Details screen.

* Process

* A Payload link to display the Callback - Payload Window for the callback.

* AnInfo link to display the Callback - Info Window describing the callback response.

* A Retry button is available for callbacks with a Skipped or Failed status.

Callback - Payload Window

The callback payload window shows the field name and value for each field in the payload.

Select Done to close the window.

Figure 2-19 Callback Payload Window

RPASCE_START_JOB Payload

externalURL dsdsds

processMame RPASCETEST_RPASCE_START_PROCESS
processExecutionld RPASCETEST_RPASCE_START_PROCESS~646
activityName RPASCE_START_JOB

activityExecutionld 2330070
callBackServiceDataDetail.rootProcess RPASCETEST_RPASCE_START_PROCESS
callBackServiceDataDetail.rootProcessExecld RPASCETEST_RPASCE_START_PROCESS~646
status DISABLED

activityStatus DISABLED

Done
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Callback - Info Window

The callback info window shows information about a request and response.

Select Done to close the window.

Figure 2-20 Callback Info Window

RPASCE_START_JOB Info

Info
;i:ira'clé.reta'il,épps.oa m.common.rest.exception.ReSTInvocationException: Not Found

Done

Footer

Auto Refresh: | None ¥ | Lastrefreshed: 06/27/23 22:48:20 GMT+5:30 | Refresh

The screen can be set to auto refresh periodically by selecting the pre-defined interval
from the Auto Refresh list. By default, this value is set to None on page load.

Use the Refresh button to refresh the screen immediately.

Use the Recover button to automatically attempt fixing system failures and resume the
schedule. This is useful if there is a system or communications failure that interrupts
the execution of a schedule.

Last refreshed shows the time and date of the last refresh of the interface.

Status

Status

The Status sidebar displays information about the Scheduler, Execution Engine, and
the environments that Process Orchestration and Monitoring communicates with to
execute batches.
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Figure 2-21 Status Sidebar

O =
Environment Status X
Last Updated: 6/19/23 at 08:46PM | O |
Scheduler Admin
Execution Engine Config
Q AlF DATA
Health Check &
.:] Active
€9 RPAS
Health Check &
.:] Active
€3 AIF APPS
Health Check &

.:] Active

Scheduler

Displays the status of the Scheduler, and an Admin link to enable or disable the scheduler
for a particular batch schedule in the Scheduler Administration window.

Execution Engine

Displays the status of the execution engine, and a Config show configuration of the
execution engine in Execution Engine Configuration.

Environment Statuses

Displays the following for each environment:
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Figure 2-22 Environment Status

1 2 3 4

5
€9 MERCH {
Health Check &

.3 Active

1. Status - Icon indicating the current status of the integration with the environment.
This will be either success 0 or error ?B

2. Schedule - Display Name of the Schedule

3. Health Check - Opens the Health Check for the schedule.

4. Activel/Suspended Switch - Toggle button to suspend or activate the schedule.
Suspending the schedule prevents new job run requests from being processed by
POM. Jobs that are already running will keep running and won'’t be terminated.
Activating the schedule causes POM to resume processing all job requests for the
schedule.

5. Link - An icon which indicates if Inter-Schedule Dependencies are enabled or
disabled.

Download Cycle Summary

Use the Download Cycle Summary window to download information about a
completed batch cycle:

1. Click Download Cycle Summary in the Batch Jobs Header.

The Batch Cycle Summary window opens.
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Figure 2-23 Download Cycle Summary Window

Download AIF DATA Cycle Summary for O...

Cycle

Nightly hd ’

Type
@ Csv (O JSON

‘ Cancel H Download H Open Report ‘

2. Use the Cycle menu to select the cycle for which to download the summary.
3. Select the Type of data to download: CSV (comma-separated values) or JSON.

4. Click Download to download the summary file, or click Cancel to close the window
without downloading.

5. Click Open Report to open the Batch Jobs Timeline window.

Scheduler Administration Window

The Scheduler Administration window allows you to enable or disable batch schedules.

When the Scheduler is disabled for a particular schedule, tasks will still be scheduled and will
still trigger at the specified time but will immediately move to the Cancelled state.

Select the Done button to close the window.

Figure 2-24 Scheduler Administration Window

Scheduler Administration
Administration

AIFDATA @) Active

RPAS .3 Active

AFArPs  [l) Active

Done

Execution Engine Configuration

The Execution Engine Configuration window displays configuration of communication
between the user interface and the execution engine.
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Select the Done button to close the window.

This window displays the following configurations:

Figure 2-25 Execution Engine Configuration Window

Execution Engine Configuration

Configuration

Executor Service Polling Interval Seconds
Monitoring Service Polling Interval Seconds

Thread Pool Size

Done

* Executor Service Polling Interval - Determines the number of seconds between
each polling interval for the batch execution process on Process Orchestration and
Monitoring.

* Monitoring Service Polling Interval - Determines the number of seconds
between each polling interval for the monitoring process on Process Orchestration
and Monitoring.

* Thread Pool Size - Maximum number of concurrent threads permitted for use by
the Execution Engine.

Health Check

The Health Check window displays the status of the processes communicating with
the environment.
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Figure 2-26 Health Check Window

MERCHANDIZING Health Check
Severity Source

€3 ERROR Platform Services
Received Exception : oracle.retail. apps.oam.common.core.exception.OamCommonRuntimeException: OAuth client does
not have the required scope to access the componennt Platform Services
dummy
[ Auth Mode: QAuth , Credentials 53 Path: /rgbu-common-pomdev-dev363-pomfpom-idcs |

€3 ERROR External Callback
Credentials not found
test
[ Auth Mode: Basic Authentication , Credentials S3 Path: pom,/rgbu-common-pomdeyv-dev363-
pom,/schedules/MERCH fexternal-callback |

% WARNING POM Agent UNDEFINED for Apps [[RPM]]
POM Agent URI is not defined/configured
[ Auth Mode: OAuth |

& SUCCESS Execution Engine - Pom Agent RMS
Available
http://pomags vice:B0B0,/POMAg:
[ Auth Mode: OAuth ]

& SUCCESS POM Agent RMS for Apps [[ALLOC, FDG, REIM, RESA, RMS]]
Available
http://pomagentservice:8080/POMAgent

Done

This window displays the following for each communication process:

e Severity - The severity of any errors in communication:
- @ SUCCESS - The process communicates successfully.

- *B ERROR - The process is not communicating with the environment.

- — WARNING - POM Agent is not configured / not mapped to any application.

e Source

The name of the process

The response received by the process
POMAgent URL
Auth Mode and S3 path (if applicable)

Activity Feed

The Batch Monitoring screen includes an Activity Feed icon at the top right corner.

ORACLE 2-39



Chapter 2
System Configuration

When the icon is clicked, the Activity Feed panel opens on the right side of the screen.
The panel displays up to seven days’ worth of activities performed both by the system
and by users through the user interface.

Click the close window icon (*) to close the window.

30

Figure 2-27 Activity Feed

Activity Feed X
O\--
06/21/23
17:13:43 GMT+5:30
SYSTEM

Skipped elapsed hourly cycle(s) [all ava
ilable] for all enabled flows as part of N
ightly request start since Nightly is wai
ting for 21-JUN-23

System Configuration

The System Configuration screen allows an administrator to modify parameters and
connection properties for the environments integrated with Process Orchestration and
Monitoring. It also allows an administrator to maintain POM application-level
configurations.

Select System Configuration in the Navigation Area to open the System
Configuration screen and select the Schedules tab. This tab displays the schedule
level configurations for each schedule setup for this environment.
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Figure 2-28 System Configuration

Oracle Retail Process Orchestration and Monitoring
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Configure New Schedule

When POM is first installed for a specific customer, it does not include any application batch
schedules out of the box such as Merchandising, Retail Intelligence, and so on. An Oracle
administrator or a system integrator needs to first configure those schedules before they can
be loaded (from a batch schedule spreadsheet). Configuring a new schedule entails setting
up schedule properties such as the schedule name and description, customer environment
information for callbacks. It also entails setting up the location of different components and
services with which different POM components need to interact to function properly.

Configuring a new schedule is typically done upon provisioning the environment by Oracle
operations. If for any reason the configuration has not yet been done by Oracle, an
administrator can alternatively accomplish that through the UI.

To configure a new schedule, click the Configure New Schedule button at the top right of

the Schedules tab of the System Configuration screen. The Configure New Schedule window
is displayed.
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Figure 2-29 Configure New Schedule

Configure New Schedule

Schedule Configuration Job Agent Job Type
* Schedule Hame WURL Hame: url Qiuth Scope

Hame

Desaription

External System Configuration Schedule Variables

L Type Variable Name: Value
Username

Password + Add Anothes

Services

Platform Services Type Application URL

uRL
=z E
BOH Process Flow UIRL

AMS Web Services URL

APAS Web Services URL

The following new schedule information can be set on this window:

* Schedule Configuration - This is for identifying and describing the schedule.
Attributes for this section are:

— Schedule Name (Mandatory) - A short identifier of the new schedule. This
usually matches the main application name such as Merchandising, RI, and so
on.

— Description (Mandatory) - A short description of the schedule.

* External System Configuration (Optional) - This identifies an external system,
typically a customer's environment. This is needed for optionally notifying the
customer's system of a job failure or success. This feature is also referred to as
Callback. Attributes for this section are:

— URL
— Username
— Password

» Platform Services (Optional) - Internal Oracle services for retrieving information
stored there by other applications or systems. Attribute for this section is:

- URL

* Job Agent (Mandatory) - The Job Agent is a component of POM responsible for
submitting the request to execute a batch job. This is usually deployed in the same
location as the application where the jobs actually run. The same agent can be
used for multiple schedules. If the schedule being configured contains multiple
applications, it is optional to add an agent for each application. This isn't a
common practice however as an agent can handle running multiple applications.
Attribute for this section is:

- URL
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< Note:

For custom schedules, the Agent URL must be set to http://
pomagentservice:8080/POMAgent. This will enable POM to use its internal/
common Agent to run jobs.

* Schedule Variables (Optional) - These variables hold System (POM) level
configurations such as IDCS or OCI IAM URL, or Job level configurations such as batch
directory, DB_ALIAS, and so on. The job level configurations can also be defined on the
batch schedule spreadsheet. Attributes for this section are:

— Type - Job or System
— Variable Name
— Value

e Services (Optional) - This section allows for entry of services POM integrates with.
These include the BDI Process Services, IDCS or OCI 1AM, and all services
corresponding to the different applications with service-type batch jobs. Attributes for this
section are:

— Type - This is a drop down for all the possible service types; for example, the Rl Web
Services URL which POM would use to invoke RI service-based batch jobs.

— Application - Application Name to which this service corresponds such as RI.
— URL

« Job Type (Optional) - This is an optional section for setting up one or more custom job
types other than the standard, pre-defined job types provided by the retail applications,
such as EXEC, RI, RASE, BDI, RDS, OB, OMS, and RPAS. The user then associates a
custom job type with the base URL for endpoints at the destination system. These are
endpoints for starting a job, restarting a job, killing a job, checking status of a job, fetching
the log for a job, and validating the URL. By setting up a custom job type, the user must
then create a custom schedule spreadsheet containing jobs with that job type. When this
batch schedule runs, POM executes that job using the corresponding, defined Start
endpoint. If the user misses the opportunity to configure the job type at this point, they do
have the opportunity to add that using the Job Type Configuration screen (see Create /
Edit Job Type for more information). Attributes for this section are:

— Name — A short, alphanumeric identifier of the job type. This typically reflects the
system or application where associated jobs are to be executed (for example, RDS).

— URL - Base URL for endpoints at the destination system where batch is to be
invoked (for example, https://server/services/batch).

— OAuth Scope — Authentication scope for accessing the batch endpoints at the above
URL.

Schedule Settings and Connections Configuration

Select the Schedules tab on the System Configuration screen to configure the settings and
connections for an environment.

The following information is shown for each environment:
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RI 23.2.301.0 (RI)

» Display Schedule Name.
e Schedule version number.

*  Schedule name abbreviation (in parenthesis).

# Note:

This is the name to be used when calling POM APIs.

Business Date: 23/06/23 System Options
Last Schedule Update:

» Business Date - Date for which the specific schedule's batches will run next.

* The system options are a set of key-value pair of attributes and values specific to
the given schedule such as location of directories or throttle enabling setting.
System options can also be used to define shell script warning or error exit codes.
If any such codes are specified, they will cause a shell script based job to fail or
complete with warning.

Examples of system options:
Last Schedule Update - Last date on which the schedule was updated.
* System Options link

Each Schedule is associated with a number of system options specific to its
environment and settings. Those can be edited by clicking the System Options
link located next to the Business Date.

Figure 2-30 Edit System Options

System Options for Rl Job Admin x

Options

.........

F At Syate Gptin
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The system options are a set of key-value pair of attributes and values specific to the
given schedule such as location of directories or throttle enabling setting. System options
can also be used to define shell script warning or error exit codes. If any such codes are
specified, they will cause a shell script based job to fail or complete with warning.

Examples of system options:

Key Value

enableThrottling FALSE

WarningCode110 Some input files were not processed
ErrorCode40 Input file corruption detected

The user can edit the values, add or remove options.

* Settings - See Edit Settings for detalils.

- s
Settings
Data Retention Days 30
Long Run Average Time Multiplier 2
External Dependencies Enabled
InterSchedule Dependencies Enabled
— Data Retention Days
— Long Run Average Time Multiplier
— External Dependencies
— InterSchedule Dependencies
e Throttling - See Edit Throttling for details.
- a
Throttling
RIS Throttle Limit 12

— Job Agent Throttle Limit

Environment - See Edit Environment for details.

Environment

RIS Unknown
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— Job Agent name (for example, RPASCE). This also acts as a link which, when
clicked, opens the Job Agent Configuration Window.

— Job Agent version
» External Configuration - See Edit External Configuration for details.

e
External
Configuration
External URL
http: //externalstatusurl
External Status Update Mode ALL
Credentials No

— External URL
— External Status Update Mode
— Credentials
* Job Type - See Create / Edit Job Type for details.

Job Type

RDS

— Job Type - For example, RDS.

Edit Settings

To edit the settings for an environment, click the edit icon #"in the Settings section to
open the Settings window.
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Figure 2-31 Edit Settings Window

Settings for RPASCE 23.1.201.0

" Data Retention Days ]
E‘

Enter a number greater
than or equal to 1
Long Run Average Time Multiplier
2

" Default Average Run Time
&0

" Business Date:
06/06/2023

Background Jobs [} Disabled
External Dependencies ([ ) Enabled

InterSchedule Dependencies (_ JlJ Disabled
- Repa“conflg s s EEEEEEEEEEEEEEsEEEEEEmSEEEEEEESEEEEEEEEEE.

Repave Strategy @ Fixed O Variable

" Window Duration 3,600 Seconds
Target Batch Duration 150 Minutes
Cancel 0K

The following settings are available in this window:

Data Retention Days - Number of days for which data is to be retained

Long Run Average Time Multiplier - Used to calculate when a job is considered long
running.

If a Threshold Run Time is specified on the Edit Job popup of the Batch Administration
screen, then a job is deemed long running if its current run time exceeds that value.
Otherwise, if a Threshold Run Time is not specified, then the job is deemed long running
when its current run time exceeds this Long Run Average Time Multiplier times the
average run time of that job. For example, if a job's average run time is 3 minutes, and
the Long Run Average Time Multiplier is 3, then the job is considered long running if it
has been running for at least 9 minutes. A notification is sent when a job is deemed long
running.

Default Average Time - Used instead of multiplying a job’s average run time by the
Multiplier (on this screen) when the job does not have run history. This is to determine
whether a job can run on a certain node when the Node Repaving is upcoming. For
example, say a hode’s repaving is taking place in 30 minutes. If a job has a run history
and its average runtime multiplied by the Multiplier is greater than 30 minutes, then the
job will run on a different node. If however the job has no run history, then this Default
Average Time is used instead.

Business Date - The earliest business date for which to run batch schedules. See
Business Date Explained for an explanation of how POM uses this setting.

Background Jobs - Enable or disable background jobs.

External Dependencies - A switch for enabling or disabling external dependencies.
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* InterSchedule Dependencies - A switch for enabling or disabling InterSchedule
dependencies.

* Repave Strategy - This strategy together with the next field's value is used to
determine if a job should be allowed to run on a particular server node. When a
node is scheduled to be repaved (updated with the latest software patch), no batch
job should be running on it when the repave starts. To prevent such a situation, a
best guess is needed as to when a node should stop accepting jobs to be run.
There are two strategies for determining when that time is:

— Fixed: Uses the next field's value (Window Duration - in seconds) to
determine the time at which the node will start rejecting requests for running
jobs. For example, if this value is 3600 seconds, the node will stop accepting
requests one hour before the repave starts.

— Variable: Multiplies the next field's value (multiplier) with the job's average run
time to determine if the node likely has enough time to run the job to
completion. For example, if the multiplier is three and the job about to be
submitted for running on this node has an average run time of five minutes
and the repave is due to start at a time longer than the 15 minutes (the product
of the two numbers), the job will be allowed to run. Otherwise, it won't be.

# Note:

If a job does not have a run history (therefore does not have an
average runtime), then the Default Average Time (also defined on
this screen) is used instead of multiplying a job’s average run time by
the multiplier field defined next.

*  Window Duration / Multiplier - This field is dynamically altered on the screen
depending on the previous field's value and is used in conjunction with the
previous field. See the previous field's explanation for details.

e Target Batch Duration - This is in minutes. This value is used as a target/
baseline on the bar graph in the Batch Timings section of the Nightly Batch
Summary report. See the Nightly Batch Summary report in the Reports section of
this guide.

Select OK to save the changes or select Cancel to exit the window without saving
changes.

Business Date Explained

When the business date is initially set, it's supposed to be set as the First Run
Business Date. It's meant for the POM application to compare to the Current Business
Date (shown below the Business Date on the screen). If the (First Run) Business Date
is earlier than the Current Business Date, POM will run the next batch schedule for the
day after the Current Business Date. If the (First Run) Business Date is later than the
Current Business Date, POM will run the next batch schedule for that date rather than
the day after the Current Business Date.
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< Note:

The Current Business Date advances automatically every time batch completes for
the day

The reason the (First Run) Business Date is updatable on this screen, is to give the ability to
start the next schedule run at that date, skipping some run days. Here are a couple example
scenarios:

Scenario 1: Common Scenario

System Configuration screen's Business Date: 11/28/2019

System Configuration screen's Current Business Date: 08/12/2019
The next batch schedule run will be for business date 08/13/2019.

When that batch run starts, the Current Business Date advances to 08/13/2019 and the
screen is updated accordingly.

Scenario 2: Skip a Few Days

System Configuration screen's Business Date: 11/28/2019

System Configuration screen's Current Business Date: 08/12/2019

User changes the Business Date on the System Configuration screen to 08/18/2019
The next schedule run will be for business date 08/18/2019.

When that batch run starts, the Current Business Date moves to 08/18/2019 (since the (First
Run) Business Date is greater than Current Business Date) and the screen will be updated
accordingly. The (First Run) Business date will remain at 08/18/2019 until changed by an
administrator on this screen.

Edit Throttling

The throttling settings can be changed by selecting the edit icon #"in the Throttling section to
open the Throttling window.

Figure 2-32 Edit Throttling Window

Throttling for MERCH 23.0.104
ALLOC Job Agent

Application Throttling Value

ALLOC 10

Cancel OK
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This window allows for update of the throttling value for each application hosted on this

Job Agent.

Select OK to save the changes or select Cancel to exit the window without saving

changes.

Edit Environment

The environment settings can be changed by selecting the edit icon #"in the

Environment section to open the Environment window.

" Note:

request to execute a batch job.

Figure 2-33 Edit Environment Window

Environment for RPAS 23.3.301.0

Platform Services URL
https://server:port/.._. /RetailAppsPlatformServices

Job Agents Services

Job Agents
Application Name URL
Multiple v RPASIA http://pomagentservice:3080,/POMAgent

Select Applications
AP X | MFP ®  RDF X | RPASCE X

+ Add Another

Environment for RPAS 23.3.301.0

Platform Services URL
https:/fserverport/... /RetallAppsPlatformServices

Job Agents Services

Services
Type Application URL
BDI Process Flaw UF - AP - ®yz.COM

+ Add Another

One schedule can be supported by one or multiple Job Agents. Usually, the
mapping is one Job Agent to an application.

Also, the Job Agent is a component of POM responsible for submitting the

Version

Unknown

Cancel OK

Cancel OK

At the top of the Environment window, the user can set the Platform Services URL.

ORACLE
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The window then provides two tabs: the Job Agents tab and the Services tab.

On the Job Agents tab, the user can add or change the following Agent related information:
* Application - application hame

* Name - Agent's name

* Job Agent Version - Release version of the Agent

 Job Agent URL

On the Service tab, the user can add or change services related information. These are
services that POM integrates with, such as BDI Process Services, IDCS or OCI IAM, and all
services corresponding to the different applications with service-type batch jobs.

Select OK to save the changes or select Cancel to exit the window without saving changes.

Job Agent Configuration Window

ORACLE

The Job Agent Configuration window displays configuration information about the selected
Agent.

An Agent is the component usually deployed alongside the application for which the batch
runs. It receives requests from the POM application, usually deployed on a common server.
These requests direct the agent to invoke the actual job execution on the target application.

Select the Done button to close the window.
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Figure 2-34 Job Agent Configuration Window

DR _

RPASCE Agent Configuration

Configuration Settings

Name Value
supportedApps AP,MFP,RDF,RPASCE
isRDSIntegrated true
scheduleName RPASCETEST
Throttle Groups
Group Name Throttle Limit
RPASCETEST 10
RPASCETEST_AP 0
RPASCETEST_MFP 0
RPASCETEST_RDF 10
RPASCETEST_RPASCE 10

Configuration URLs

Type url
DS hitps://idcs-cat9B88TbTead 451 2a38362%e.identity.c?dev2.oc9gadev.com
POM hitps://home.retail.us-phoenix-1.0cs.0¢-test.com /rgbu-common-pomdev-devi210-pom
RDSURL ugiyftucxgghvj
RPASWSURL hitp://pomagentservice:8080/POMAgent
Job Types Configuration
Jab Type Definition Url
CUSTOM Infa http://customjob.com

This window displays information about the Agent's Configuration Settings, Throttle
Groups and Job Types.

It also displays a Configuration URLs section which lists service URLs that POM
needs to operate. These include service URLSs for calling endpoints to execute batch in
the case where the jobs are service-based (versus shell-script-based) and are of pre-
defined job types such as RI, RASE and RPAS.

The Throttle Groups section displays throttle limits (the maximum number of jobs that
can execute concurrently). These are defined either on the batch schedule
spreadsheet or on the Throttling section of this System Configuration screen.

The Job Types Configuration section displays all custom job types defined either on
the batch schedule spreadsheet or on the Job Type section of this System
Configuration screen.
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This window also features a Sync With POM button (formerly called Publish). When clicked,
it will synchronize the information on this screen from POM to the Job Agent. These changes
are also synchronized automatically to the Job Agent upon the daily creation of a new
scheduler day.

Edit External Configuration

Job Types

ORACLE

The external configuration settings can be changed by selecting the edit icon #"inthe
External Configuration section to open the External Configuration window.

Figure 2-35 Edit External Configuration Window

External Configuration for Rl 23.2.301.0

External Status URL
http://....
External Status Update
Mode ALL v
Credentials
Update Credentials

‘ Cancel H OK ‘

The following settings are available in this window:

External Status URL - Customer system's URL that is called when POM is to notify the
customer's system. Note that this calling feature is also referred to as Callback.

External Status Update Mode - Job status for which POM is to call the customer's URL.
This menu has the following options:

— ALL - POM will make a call for each job's execution regardless of success or failure.
— FAILED - POM will make a call only for failed jobs.
— NONE - POM will never make a call.

Update Credentials - When clicked, Username and Password fields are shown. Setting
these values will update the credentials POM uses to call the customer's URL.

Select OK to save the changes or select Cancel to exit the window without saving changes.

Job Types window displays a table of configured job types. The user can edit or delete an
existing row or create a new job type.
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See the “Generic ReST Jobs” chapter of the POM Implementation Guide for additional
details on setting up custom schedules with custom job types.

Figure 2-36 Job Types Table

Rl Job Type Configuration £

Job Types

Actiom Vi ® e T W R o

© e Job Stan Job Restaet. @ Job St © Jobkal = Joblegs = Vabdation = Scope = e

Each row contains the fields:

e Job Type - A short, alphanumeric identifier of the job type. This typically reflects
the system or application where associated jobs are to be executed (for example,
RDS).

 URL - Base URL for endpoints at the destination system where batch is to be
Invoked (for example, https://server/services/batch).

e Job Start - Endpoint for invoking the execution of a job.

e Job Restart - Endpoint for restarting the execution of a job after failure.
e Job Status - Endpoint for POM to fetch the status of a started job.

e Job Kill - Endpoint for terminating the execution of a running job.

e Job Logs - Endpoint for fetching the log(s) for a job.

e Validation - Endpoint for validating that the endpoints are reachable.

e Scope - Authentication scope for accessing the above endpoints.

e Custom Credential - Displays a tick mark if the credential is custom created by
the user for that job type. Else, blank.

Create / Edit Job Type

A new job type can be created by selecting the Create icon @ in the Job Types section
to open the Job Type Configuration window. Alternatively, an existing job type

configuration can be changed by selecting the edit icon s
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Figure 2-37 Create Job Type

Create New Job Type For RDSTEST
Job Type
url
Job Start
Job Restart
Job Status
Job Kill
Job Logs

Validation

Figure 2-38 Edit Job Type

JobType2 Job Type

url http://jobtype2.com|

Job Start fstartlobType
Job Restart frestartJobType
Job Status [fstatusobType

Job Kill
Job Logs

Validation

# Note:

OAuth Scope
OAuth Credentials () Use System Default

Mo Credentials Configured

Client Id

Client Secret

QAuth Scope | scopel
DAuth Credentials O Use System Default

Client Id:
jobTypeCustomCredentials

Chapter 2
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(® Use Custom

Close

Required

Required

Cancel Ok

(® Use Custom

Update

Cancel Ok

If the selected job type is using custom credentials, the popup will also show the

corresponding client id.

Select OK to save the changes or select Cancel to exit the window without saving changes.
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See the “Generic ReST Jobs” chapter of the POM Implementation Guide for additional
details on setting up custom schedules with custom job types.

System Settings

Select the System tab in the System Configuration screen to view the system
configuration for Process Orchestration and Monitoring.

Figure 2-39 System Information Screen

G —

Schedes | Symem GubalBn | ResoveBising Schetuls | Congure Hew Schesie

POM 25.2.401.0

Harre
oV

uviormas Hame

POMOEY

Pritess Servies UL

it . b0 e i b2 g P vices

Pstfons Sarvices AL

i horme rd s s oca -ttt g comenon- pormedes- v -, Mssldopmaticisarcices

B0 Integration

e Duta Seare URL
g

Edit System Settings

Select the edit icon # (not shown) located at the rightmost of the System Information
window to enable the editing of information on this window.
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Figure 2-40 Edit System Settings Window

System Settings

System

Environment Name | QA2

Customer Name pomQA

Environment
Process Services URL https://home.retail.us-phoenix-1.ocs.oc-test.com/rgbu-common-pomga

Platform Services URL https://home.retail.us-phoenix-1.ocs.oc-test.com/rgbu-common-pomq

RDS Integration E Enabled

Retail Data Store URL http://rdsurl.com

Cancel OK

The following settings are available in this window:

* Environment Name — This is the physical environments name such as '<customer
name> stage 1'.

¢ Customer Name

* Process Services URL — This URL is set at install time and cannot be changed on this
window. It shows the value of POM's services URL.

*  RDS Integration — Flag indicating whether POM is integrated with Retail Data Store
(RDS)..

Retail Data Store URL — Shows the value of the RDS URL. It can be updated on this
window.’

Select OK to save the changes or select Cancel to exit the window without saving changes.

Remove Existing Schedule

Select the Remove Existing Schedule button to open the Remove Schedule dialog. This
screen removes the selected schedule (from the drop down) from the POM Application.

ORACLE 2.57



Chapter 2
System Configuration

Figure 2-41 Remove Schedule Screen

Remove Schedule

Warning
This action completely removes the selected schedule data from the System
and cannot be undone

Select Schedule = RPAS X

" Comment | RPAS Schedule - Remove

Cancel Ok

Global Edit

Select the Global Edit button to open the Global Edit screen. This screen sets
configurations for all the schedules. Refer to the sections above for explanation of the
different configurations.

Figure 2-42 Global Edit Screen

o Gt —

Global Edit *®

D Sl i b oy i a1 8 5 Feduir,
Settings

apoty el Vi

[= =}

O 00

External Configuration

Apoy [ Vil
External RS,

Extermal Seatun Upsate Mot

o000

[ hername

Pavmeecrd

Use the Apply check boxes to activate the fields for the settings to be applied to all
schedules. The following settings can be applied to all schedules:

» Data Retention Days
* Long Run Average Time Multiplier

e Business Date
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» Background Jobs
» External Dependencies
* InterSchedule Dependencies
* External URL
* External Status Update Mode
* Repave Strategy
* Credentials:
— Username

— Password

Batch Administration

The batch administration screen provides the ability to maintain information specific to the
batch schedule.

Select Batch Administration in the Navigation Area to open the Batch Administration tab.

Figure 2-43 Batch Administration

Oracle Retail Process Orchestration and Monitoring

[+
B
@
&

gy UE9) | Recuring {1908) | Stasciiloes (131) SO | Bt | bmpart

AIF Nightly

i 2| 7| B owa Clatie 48
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ACAHCT_DATL PROCESS o LT o Type00_JON_ M| [rame=PLP R

ANALYZE TEMP_PROCESS 8 o HEOL ot By OB UL

BATCH TIAL_START PSS s R

BATEH_ VAL EATIGN PROCESS

i B

0

e

Batch Administration Header

The Batch Administration header includes the following options:

1. Batch Tiles - There is a batch tile for each software environment Process Orchestration
and Management connects to. Select a tile to show the batch processes for that
environment. See Batch Tiles for more information about these tiles.

2. Cycle Tabs - Displays the cycles for which batch information is to be maintained.
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Select a cycle tab to see the batch details for that cycle. The following cycles are
available:

e Nightly
* Recurring
e Standalone

Sync with MDF — MDF is the Module Definition Framework maintained in the
Retail Home Customer Module Management module of Retail Home. Using the
Sync with MDF button in POM will sync the modules defined in POM with those in
Retail Home. Nightly jobs belonging to those modules are then enabled or
disabled based on their state in Retail Home.

When Sync with MDF is clicked for the selected application schedule, the user is
presented with a warning message advising that jobs may be enabled or disabled
as a result of the synch action.

Figure 2-44 MDF Sync — Warning Message

X

A Warning

The MDF Synch may enable or disable application modules and their related jobs based on the MDF configuration. Are you sure you want to continue?

Cancel oK

After the sync is complete, a JSON file with the batch schedule summary is
downloaded. This file contains the current and previous status of an application
and module in MDF and POM after sync.

The following is a sample of that JSON file:

"scheduleName":"RI", "synced":true, "enabledModules": |
{

"state":"MATCHED MODULE",
"mdfStatus":"ENABLED",
"prevMdfStatusInPom":"ENABLED",
"prevStatusInPom":"ENABLED",
"publishToPom":true,
"applicationName":"RI",
"moduleName":"RMI SI ONORDER",
"matchedModule" :true

"state":"MATCHED MODULE",
"mdfStatus":"ENABLED",
"prevMdfStatusInPom":"ENABLED",
"prevStatusInPom":"ENABLED",
"publishToPom":true,
"applicationName":"RI",

ORACLE"
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"moduleName":"RMI_SI WHOLESALE",
"matchedModule":true

"state":"MATCHED MODULE",
"mdfStatus":"ENABLED",
"prevMdfStatusInPom":"DISABLED",
"prevStatusInPom":"ENABLED",
"publishToPom":true,
"applicationName":"RI",
"moduleName":"RCI SI SALES",
"matchedModule":true

Also, the status of the updated jobs is changed to either 'Loaded' or 'Disabled’ based on
the module activation/deactivation in Retail Home’s Customer Modules Management.

4. Export - Use this button to export Schedule Configuration or Custom Entities for the
selected schedule and cycle. Schedule configuration includes Scheduler tasks, throttle
limit values, data retention values, notifications settings and (most importantly) which jobs
are enabled or disabled. Custom Entities include schedule customizations that a user has
performed on this Batch Administration screen such as addition of custom flows,
processes and jobs.

When clicked, the user is presented with a dialog for selecting the data to export —
Schedule Configuration or Custom Entities.

If 'Schedule Configuration' is selected, then the type of file to export (Excel or JSON) also
has to be selected.

Export AIF

Select data to export (® Schedule Configuration (O Custom Entities

Export As @® s QO .json

Cancel Export

Custom Entities can only be exported as JSON.
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Export AIF

Select datato export () Schedule Configuration (@ Custom Entities

Cancel Export

Depending on the user's browser setting, the file is either saved in the default local
file system directory or a file save/open dialog is presented first.

Opening RI_config.json X

You have chosen to open:
E RI_config.json

which is: JSON file (375 KB)
from: data:

What should Firefox do with this file?
O Save File

[ ]Do this automatically for files like this from now on.

oK Cancel

If the export is done for the purpose of applying the same configurations on
another environment (Lift & Shift), the user is recommended to export to a JSON
file. This file is then used in the Import Config function (explained below) to import
the configurations into another environment.

The user has the option to manipulate the exported file before importing back into
the same environment or a different one. In that case an export to an Excel file is
more suitable for ease of manipulation. Caution needs to be taken when
manipulating the content of the exported file, especially for maintaining proper data
format.

Refer to the “Export/Import Schedule Configuration” chapter of the Process
Orchestration and Monitoring Implementation Guide for details on applying
changes to the exported spreadsheet before importing it back in.
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5. Import - Use this button to import Schedule Configuration or Custom Entities for the
selected schedule and cycle. When clicked, the user is presented with a dialog to select
the desired type of data to import — Schedule Configuration or Custom Entities. See
Export above for a brief explanation of each.

Iimport AIF

Warning

Importing a schedule configuration will alter the current schedule’s
configuration including enabling or disabling jobs. Are you sure you want to
continue?

Select data to import
(® Schedule Configuration (O Custom Entities

(] Import Scheduler Configuration
[J Import Jobs Configuration

(] Import Notifications Configuration

Cancel

If the Schedule Configuration import is selected, the user can select to import
Scheduler tasks configuration and/or Jobs configuration and/or Notifications
configuration. The jobs configuration includes such settings as throttle values, data
retention values, enabled/disabled setting and Job Start/Completion notifications. The
Scheduler tasks are those directives for the POM Scheduler to run the different batch
cycles at specified times. The Notifications configuration includes e-mail addresses and
retention periods associated with the different notification types.
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Import AIF

Warning

Importing a schedule configuration will alter the current schedule’s
configuration including enabling or disabling jobs. Are you sure you want to
continue?

Select data to import
(O Schedule Configuration (@ Custom Entities

Cancel Import

The user can also select to import Custom Entities and provide the JSON file
containing the custom entities' data.

Once the import type is selected and the Import button is clicked, the user is
presented with a file selector dialog (not shown). User can then choose to import a
JSON or an Excel file.

When a schedule is being upgraded using the Schedule Maintenance screen or
when the schedule upgrade has failed or when a schedule is being synced, the
user is prevented from most activities on the Batch Monitoring and on the Batch
Administration screen.

| ) Some festures are disabled while a schedule iz being imported |

| ) Some festures are diszbled whils 3 schedule iz in 2 failed state |

| @ Some features are disabled while a schedule is being synched |

Each tile displays the following information:
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Figure 2-45 Batch Tile

1

l

O RPASCETEST 231.2...

Nightly: 202 /
6

Recurring:
Standalone: 47

2

1. Schedule Name and Version - Displays the abbreviation of the application or application
group and the software version. The display schedule name can alternatively be
displayed here instead of the default schedule name. The display schedule name can be
configured on the Schedule tab of the Batch Schedule spreadsheet

2. Cycles and Statuses - Displays the number of batch jobs for nightly / recurring cycle and
number of ad hoc flows / processes for standalone cycle.

Batch List

The information in the batch list depends upon the cycle chosen:
e Nightly
e Recurring

e Standalone

Actions Menu and Icons

Actions Menu and Icons
See Action Menu and Icons for common actions that can be performed through the Action
menu and the icons. You can also perform the following actions:

Table 2-2 Batch Jobs - Actions Menu/lcons and Description
]

Actions Menullcons Description

Edit and Edit icon # Select an item in the table, then select Actions > Edit or the edit
icon # to edit the item.

Enable All Use the Actions > Enable All or the Enable All button to put the
process on hold.

Disable All Use the Actions > Disable All or the Disable All button to skip

the process.

View Menu

See View Menu for information about the options in the View menu.
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The nightly cycle displays the following information for each batch:

Figure 2-46 Nightly Batch List

Baich Admintstration %

MERCHIAMMM | © mMoans o RPO0AD O RPASCE 190,008
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wed

MERCH Nightly

Actions ¥ Vi v 2T B oeacn Enabie A5

% Application Module ©  Base Phase Active Phase = Param:
ALLOC ALLOC_BA ]

ALLOT AALOC BA

ALE_PURGE_ALLOC PROCESS
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ALC_PURGE WRX_PROCESS ALLOC ALLOC BA. PURGE_
ALE_SHRMK_SESSION_PROCESS ALLDC BLLOC BA.
ALC_SNAP_SHOT_MLOC_IN_PROCESS ALLDC ALLOC BA.
ALE_SNAP_SHOT_ALOC_ OUT_PROCESS AADE ALOC BA

ALC_SMAP_SHOT_CROSS_LIMK_PROCESS
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Enabled
Job - Click the Job to open the batch in the Batch Job Details screen.
Process Name

Base Priority - An optional number between 1 and 10 (10 being highest priority)
assigned to a process-job combination. This number determines the execution
priority for the job amongst concurrent job run requests in a limited throttled
setting. The base priority is the value initially seeded from the spreadsheet for this
process-job.

Active Priority - The current priority (1-10) value once altered from the Ul. This
value if present supersedes the base priority.

Application - A schedule may be made up of multiple applications. There needs to
be at least one application.

Module - An application may be made up of multiple modules. Modules within an
application are optional.

Base Phase - An optional alphanumeric phase assigned to a process-job for
grouping of jobs in the Nightly cycle. This is used for reporting purposes only. The
Nightly Summary Report will then report total run time and elapsed time by Phase.
The base phase is the value initially seeded from the spreadsheet for this process-
job.

Active Phase - The current phase value once altered from the Ul. This value, if
present, supersedes the base phase.

Parameters - A job may be run with a list of input parameters. This column always
shows the original list of parameters.
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» Active Parameter - This column shows the customized list of parameters.

» Job Type - A Job Type is an attribute of a Job in POM and signifies the kind of Job that is
run. POM has the following pre-built Job types. Other custom job type can be used that
are built using the Job Type feature of the System Configuration screen.

— EXEC - For all shell-script based jobs

— RI - DIS-based jobs for the RI schedule

— RASE - DIS-based jobs for the RSP schedule

— BDI - BDI Jobs

— RPAS - RPAS-Web Service jobs for the RPAS schedule
— OB — OB-based jobs for the OB schedule

— OMS - OMS-based jobs for the OMS schedule

— RDS — RDS-based jobs

» Kill Cleanup Script - Name of a script that will be executed after the kill is performed. This
is an optional field as not all jobs require cleanup after termination.

» External Status Update - Job status for which POM is to call a customer's URL. The URL
is defined in the External Configuration section of the System Configuration screen. This
column has the following possible values:

— ALL - POM will make a call for this job's execution regardless of success or failure.
— FAILED - POM will make a call only for if this job fails.
— NONE - POM will not make a call.
* Notification At
— Start of Job — Send notification of type JobStarted when the selected job starts.

— Completion of Job - Send notification of type JobCompleted when the selected job
completes successfully. Note that there is a separate notification of type Error that is
sent when a job fails.

e Skip On Error - Skip this job if it fails.

»  Threshold Run Time (Seconds) - Amount of time greater than which the job is deemed
long running. If a Threshold Run Time is specified here, then a job is deemed long
running if its current run time exceeds that value. Otherwise, if a Threshold Run Time is
not specified, then the job is deemed long running when its current run time exceeds the
Long Run Average Time Multiplier (defined on the Edit Settings popup of the System
Configuration screen) times the average run time of that job. For example, if a job's
average run time is 3 minutes, and the Long Run Average Time Multiplier is 3, then the
job is considered long running if it has been running for at least 9 minutes. A notification
is sent when a job is deemed long running.

* Notes

e Job Name

* Job Wrapper Name

» Days of the Week - Days of the week for which the job is to be run.

The user can select a batch job and click the Edit icon to edit the job information.
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Figure 2-47 Edit Nightly Batch Window

Edit ALC_DAILY_CLEANUP_JOB
o
Enable Job [_Jl) Disabled
priority @ @
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Threshold Run Time
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Cancel Ok

The following information can be updated for each batch from the Edit window:

e Job Type — Choose from following pre-built Job types:
— EXEC - For all shell-script based jobs
— RI - DIS-based jobs for the RI schedule
— RASE - DIS-based jobs for the RSP schedule
— BDI-BDI Jobs
— RPAS - RPAS-Web Service jobs for the RPAS schedule
— OB — OB-based jobs for the OB schedule
— OMS - OMS-based jobs for the OMS schedule
— RDS — RDS-based jobs

Other custom job type can be used that are built using the Job Type feature of the
System Configuration screen.

e Enable Job — Enable or disable a job
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*  Priority - The user can change the Priority of a job with a value from 1-10 (With 10 being
the highest and 1 being the lowest and 0 as default value meaning no priority set). As
long as the Priority is not modified on the Ul, it can be overridden from the spreadsheet.
However, once modified on the Ul, the priority cannot be overridden from the
spreadsheet, but only from the UI.

*  Phase — The user can select a saved phase (if any) from the dropdown. Alternatively, the
user can type in a new alphanumeric value.

»  Parameters — Add or remove from the customized list of parameters, if allowed for that
batch.

*  Kill Cleanup Script - Name of a script that will be executed after a kill is performed.

*  External Status Update - Job status for which POM is to call a customer's URL. The URL
is defined in the External Configuration section of the System Configuration screen. This
column has the following possible values:

— ALL - POM will make a call for this job's execution regardless of success or failure.
— FAILED - POM will make a call only for if this job fails.
— NONE - POM will not make a call.

* Notification At

— Start of Job — Send notification of type JobStarted when the selected job starts
execution.

— Completion of Job - Send notification of type JobCompleted when the selected job
completes successfully. Note that there is a separate notification of type Error that is
sent when a job fails.

e Skip On Error - Skip this job if it fails.

» Threshold Run Time (Seconds) - Amount of time greater than which the job is deemed
long running. If a Threshold Run Time is specified here, then a job is deemed long
running if its current run time exceeds that value. Otherwise, if a Threshold Run Time is
not specified, then the job is deemed long running when its current run time exceeds the
Long Run Average Time Multiplier (defined on the Edit Settings popup of the System
Configuration screen) times the average run time of that job. For example, if a job's
Threshold Run Time is 60 seconds, then the job is considered long running if it has been
running for at least 60 seconds. A notification is sent when a job is deemed long running.

« Notes

* Days of the Week - Days of the week for which the job is to be run.

Recurring

The Recurring cycle includes an Hourly Cycle menu. Select an hour in this menu to choose
the hour of the day during which the displayed jobs will run.

The recurring cycle includes the following information for each batch:
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Figure 2-48 Recurring Batch List
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*  Flows - Select a flow in the Flows list to view all jobs for that flow. The following
information is shown for each flow:

Flow Name
Enabled or Disabled

* Jobs - The Jobs list shows the following information for each job. The user can
also update the job by selecting it and clicking on the Edit icon. Refer to the Nightly
cycle above for an explanation of each field:

Enabled

Job - Click the Job to open the batch in the Batch Job Details screen.
Process Name
Base Priority
Active Priority
Application
Module

Base Phase
Active Phase
Parameters
Active Parameter

Job Type - Job Type of '/EXEC' Indicates that the job executable is shell script
based. All other job types, such as 'BDI', 'RI', and so on, indicate that the job is
service-based. Service-based job types require different configurations than
shell-script based.

Kill Cleanup Script - Name of a script that will be executed after the kill is
performed. This is an optional field as not all jobs require cleanup after
termination.

External Status Update
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—  Skip On Error

— Threshold Run Time (Seconds)
— Notes

— Job Name

— Job Wrapper Name

— Days of the Week

The user can select a batch and click the Edit icon to edit the batch. Refer to the Nightly cycle

above for an explanation of each field in the Edit window.

The standalone cycle includes the following information for each flow, process, and job:

Figure 2-49 Standalone Batch Sections
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Left Pane of the Screen

. Create Custom Entities - The following options are listed when clicked:
— Create Flow
— Create Process

. Filter by Invokable Name — Search for an invokable by entering a search term and

clicking on Enter. An invokable can be a flow or a process that does not belong to a flow.

*  Flows/Processes - The following information is shown for each flow/process:
—  Flow/Process Name
— Enabled or Disabled

—  Flow/Process Label
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Right Pane of Screen

* Jobs - Select an invokable (flow or process) from the left pane to view all jobs for
that flow or process. The Jobs list shows the following information for each job.
The user can also update the job by selecting it and clicking on the Edit icon. Refer
to the Nightly cycle above for an explanation of each field:

Enabled

Job - Click the Job to open the batch in the Batch Job Details screen.
Process Name
Base Priority
Active Priority
Application
Module

Base Phase
Active Phase
Parameters
Active Parameter

Job Type - Job Type of '/EXEC' Indicates that the job executable is shell script
based. All other job types, such as 'BDI', 'RI', and so on, indicate that the job is
service-based. Service-based job types require different configurations than
shell-script based.

Kill Cleanup Script - Name of a script that will be executed after the kill is
performed. This is an optional field as not all jobs require cleanup after
termination.

External Status Update

Skip On Error

Threshold Run Time (Seconds)
Notes

Job Name

Job Wrapper Name

Days of the Week

Create Custom Entities - Create Flow

The user can select Create Custom Entities and click on the Create Flow option to
create a new flow and its associated process(es) and job(s).

ORACLE
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The following information can be added to create a new flow:
* New Flow Details
— Flow Name — Name of the flow ending with CFLOW
— Comment
— Description
* Processes in Flow

Processes can be added to the flow by either creating a new process or adding an
existing process or importing processes from an existing flow.

1. Create New Process

Create Process

* Process Name CUSTOM_FLOW_DEMO_CPROCESS

Description

* Application RMS *

Predecessor

This is the First process in the Flow

Cancel Ok

As this is the first process in the flow, the Processes in Flow field is populated with
this process as shown below, marking it as the First and Last process.
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Create Flow

MERCH

New Flow Details
[P -

Destrionien

Processes in Flow

— per— erom
PP S VB oven

Predecessor Process. Process Mame

-—» CURTER_FLEW_DERD EMIOCESL

Add Existing Process

© Gomment | CLLTOM_FLOW GRS OO Eammant

Numberof Jobs =

As we have already created the first process for the custom flow, the first
process is the Predecessor for the next created process.

Add Existing Process

Select Process ‘ CUSTOM_1_CPROCESS v

Select Predecessor

| CUSTOM_FLOW_DEMO_CPROCESS X |

Create Flow
MERCH
[
Abaprocms
New Flow Details

" Fuwbiame | CUSTOM_FLOW. DEMO_CFLOW

Desrigion

Processes in Flow

2 Prstenst) P been a5ed 19 S Pl Conate Mem Prstie, 2 Exing Process, e macet e I Exnting Flom

W = V2 v
Predecessor Process = Process Name =
[ ] CUSTOM_FLOW_DEMD_CPROCESS

CUSTEM_FLOW_DEMD_PROCESS 0PV CUSTOM 1 CPOGESS

‘ Cancel H Ok

* Comment | CUSTOM_FLOW_DEMO,_CFLOW Comment

Numbes of Jobs =

COPY_CUSTOM 1 CPROCESS. 0

Import Process from Existing Flow — Select Al
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4,

Import Process from Flow

New Flow Details

* FlowMame | CUSTOM_FLOW_DEMO_CFLOW.

Deseription

Processes in Flow

=

Select Flow

Option (@ Select All

CUSTOM_FLOW_TEST_CFLOW

Predecessor Process ©

Lo ]

CUSTEM FLOW_DEMD_CPROCESS
COPY_CUSTOM,t CPROCESS
COPY,CUSTOM PROCESS, TEST, 1 CPROCESS.
COPY_COFY_CUISTOM 5 CPRIOCESS.
CORY_COPY_ CUSTOM,_CPROCESS.

0PV CUSTOM_PROCESS, THST 2 CPROCESS

VB vewn

et P Exating Flow

Process Name =
CUSTOM,_FLOW_DEMO_CPROCESS
COPY_CLISTOM 1 CPROCESS.
COPY_CUSTOM _PROCESS TEST 1 CPROCESS
COFY_C0PY, CUSTOM, 3 CPROCESS
COPY_COPY_CUSTOM_CPROCESS
COPY_CLISTOM _PROCESS_ TEST 2 CPROCESS

OB _COPY, CUSTOM 2 CPROCIESS

O Import Selective Process

All processes from the selected flow are added.

‘ Cancel H Ok ‘

° Comment  CUSTOM_FLOW.DEMO_CFLOW Commant

Successor Process =

COPY_CUSTOM_§ CPRDCESS.
COM_ELISTOM_PIOCESS, TEST_1 EPROCESS
COPY_COPY_{USTOM 3 CPROCESS
CORY_COPY_IUSTOM CPROCESS
CORY_CUSTOM _PROCESS,_TEST_2 CPROCESS
COPY_COPY_{USTOM 2 CPROCESS

[ Lo ]

Import Process from Existing Flow — Import Selective Process

Humber of Jobs =

= ElE=E =
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CUSTOM_FLOW_TEST_CFLOW v

@® Import Selective Process

~

Number of Jobs <

CUSTOM_PROCESS_TEST_1_CPROCESS 1

COPY_CUSTOM_1_CPROCESS 2
CUSTOM_PROCESS_TEST_2_CPROCESS 2
COPY_CUSTOM_2_CPROCESS 3

Ok

Only the selected processes from the flow are added.

MERCH

New Flow Details

* FlowMame  CUSTOM FLOW_DEMD CFLOW

Desngnon

Processes in Flow

adiod 35 0 Flow

At v Vew v

Predecessor Process ©
CUSTOM_FLOW_DEMO_(PROCESS
COPY_CUSTM_1_CPROCESS

0 CLTEM_PRCCISE THET | EAOCiss
COPY_COBY_ CLETOM 3 CPROKCISS
COPY_COPY_ELSTOM LPROCESS

COPY_CUSTOM_PROCESS,_TEST 2 CPROCESS

Jobs in Process

Add Process

ProcessName =

CUSTOM_FLOW, 6N, CPROCESS
COPY_CUSTOM1CPROCESS

COPY_CUASTOM SROCESS_TEST_{_CPRIKESS.
COPY_COPY_IATOM 3 CPROCESS
COPY_C0PY CLATOM EPROCESS
COPY_CUSTOM PROCESS, TEST_2 CPROCESS.

COPY_COPY_CUSTOM 2 CPROCESS

Add 3o

Commant | CLSTOM_FLOW_DEMO CFLOW Commenn

Successor Process & Mumber of Jobs &
COPY,CUSTOM, | (PROCESS.

COPY,CUSTOM, PROCESS, TEST, 1 CPROCERS '
COPY_COPY. CUSTOM 3 CPROCESS

L 0 CUSTOM CPMGCESE

COPY_CUSTOM PROCESS TIST 2 CRROCESS 1
COPY_COPY_CUSTOM 3 CPROCESS 2

L= 3

After adding the desired processes, click the Next button to add job(s) to the
processes. Every process in the custom flow should have at least one job.

New or existing jobs can be added to the selected Process by either creating a
new job or adding an existing job or importing a job from an existing process.
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Create New Job

* JobName | DobNa e it Parameters

Description Kill Chearup Seript

"lbType R - Threshold Run Time (Sec)

* Application | RI - [ sunday
* skipOnError | () Menchy
* Fixed Parameter | 0 Tarsdr
* Days of the Week [ Wednesday
[0 Thursday
[ Friday

O Saturday

Job Name

Uniquely identifies a job. The Job Name should be in upper case with no spaces.
Use an underscore if needed. It should end with _cJoB. If the same job is part of
multiple processes (for example, different parameters are passed), define a
separate job for it.

Description

Short description of the batch job. There should be no special characters.

Job Type

*  Can be one of the following values: EXEC, RI, RASE, BDI, RPAS, OMS, OB, Or RDS.

*  Can also be a custom job type defined either in the JobType tab of the Batch
Schedule spreadsheet or built using the Job Type feature on the System
Configuration screen.

Application

This holds the application that the batch job belongs to. It should be a valid
application defined in the Application tab of the Batch Schedule spreadsheet.

Skip On Error

If the switch is on, it indicates that the job should be skipped if it fails, and the
batch schedule should continue to run. Otherwise, the batch schedule is stopped.

Fixed Parameter

If the switch is on, it indicates that the parameter value can be changed on the
Batch Administration screen. The switch should be on if the parameter cannot
have a default value, or if the parameter can have different values.

Parameters

*  This holds the entire parameter value to be passed into a shell-script type
job. This field is case sensitive.

*  For parameters that can have multiple values (for example, purge days
parameter), provide a default value so that the batch can still be executed.

* A placeholder parameter #JobCtxt.businessDate can be used for jobs that
require a POM business date parameter (DDMMYYYY format).
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— Kill Cleanup Script

Absolute path of the cleanup script to be run after killing a shell script
(EXEC) type job from the POM Ul. It can include arguments as well along
with the script.

For example: /u0l/retail/app/batch/app cleanup script.sh
— Days of the Week

Days of the week for which the job is to be run if scheduled. Select all if
job is to be run every day of the week.

For example, if a job is part of a process that runs every day and Days of
the Week is set to MONDAY and FRIDAY, this job will only run on those two
days while the rest of the jobs may run every day.

— Threshold Run Time (Sec)

Amount of time greater than which the job is deemed long running. If a
Threshold Run Time is specified here, then a job is deemed long running
if its current run time exceeds that value. Otherwise, if a Threshold Run
Time is not specified, then the job is deemed long running when its current
run time exceeds the Long Run Average Time Multiplier (defined on the
Edit Settings popup of the System Configuration screen) times the
average run time of that job. For example, if a job's average run time is 3
minutes, and the Long Run Average Time Multiplier is 3, then the job is
considered long running if it has been running for at least 9 minutes. A
notification is sent when a job is deemed long running.

2. Add Existing Job

Add Existing Job
* Select Cycle ~ Adhoc -
|
* Select Job AGG_SRVC_JOB hd

Ok Ok and add another

3. Import Job from Existing Process

Import Job from Process

* Select Process COPY_W_RTL_MARKET_PROD_DH_MTX_DS_PROCESS b

Cancel Ok

After adding the desired job(s), click the Create button in the footer to create
the custom flow with its associated process and jobs.
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The custom flow and its jobs are created and displayed in the Standalone tab. A
Custom tag is also seen along with the flow name in the left pane to indicate that it
was a custom, user-created flow, as opposed to being seeded from the batch
schedule spreadsheet.

Enable the Custom Flow

The custom flow is disabled by default and can be enabled by clicking the enable/disable
Enabling the Custom Flow also enables its batch jobs.
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Edit the Custom Flow

The Custom Flow can be edited by clicking on the Edit icon below the flow name. The user
can then edit the flow details, add/edit/delete processes and add/edit/delete jobs.
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Edit Flow
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Delete the Custom Flow

The Custom Flow can be deleted by clicking the Delete icon below the flow name. For
audit purposes, a comment is required when deleting a custom flow.

Create Custom Entities - Create Process

The user can select Create Custom Entities and click the Create Process option to
create a new process and its associated job(s).

Jobs in New Process

[P ————

. T Bown 4+ #

Erabled ok M Dwcripmon 3

S

The following information can be added to create a new process:
* New Process Details

— Process Name — Name of the process ending with CPROCESS.
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—  Comment
— Description
Jobs in New Process

New or existing jobs can be added to the selected Process by either creating a new job
or adding an existing job or importing a job from an existing process.

1. Create New Job

Create Job
© Job Mamne ; b Narre o end wi 3 Parameters
Description Kill Clearup Seript
*JbType R - Threshold Run Time (Sec)
Application Rl - [ sunday
] Monday
skiponError  _ O
] Tuesday
Fixed Parameter | o
® Dwys of the Weak [ Wednesday
[ Thursday
[ Friday
[ saturday
Cancel ok

Uniquely identifies a job. The Job Name should be in upper case with no spaces.
Use an underscore if needed. It should end with _cJoB. If the same job is part of
multiple processes (for example, different parameters are passed), define a
separate job for it.

— Description
Short description of the batch job. There should be no special characters.
— Job Type

*  Can be one of the following values: EXEC, RI, RASE, BDI, RPAS, OMS, 0B, and
RDS.

*  Can also be a custom job type defined either in the JobType tab of the Batch
Schedule spreadsheet or built using the Job Type feature of the System
Configuration screen.

— Application

This holds the application that the batch job belongs to. It should be a valid
application defined in the Application tab of the Batch Schedule spreadsheet.

—  Skip On Error

If the switch is on, it indicates that the job should be skipped if it fails, and the
batch schedule should continue to run. Otherwise, the batch schedule is stopped.

— Fixed Parameter

If the switch is on, it indicates if the parameter value can be changed on the
Batch Administration screen. The switch should be on if the parameter cannot
have a default value, or if the parameter can have different values.

— Parameters
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*  This holds the entire parameter value to be passed into a shell script
type job. This field is case sensitive.

*  For parameters that can have multiple values (for example, purge
days parameter), provide a default value so that the batch can still be
executed.

*  Placeholder parameter #JobCtxt.businessDate can be used for jobs
that require a POM business date parameter (DDMMYYYY format).

— Kill Cleanup Script

Absolute path of the cleanup script to be run after killing a shell script
(EXEC) type job from the POM UL. It can include arguments as well along
with the script.

For example: /u0l/retail/app/batch/app cleanup script.sh
— Days of the Week

Days of the week for which the job is to be run if scheduled. Select all if
job is to be run every day of the week. For example if a job is part of a
process that runs every day and Days of the Week is set to MONDAY and
FRIDAY, this job will only run on those two days while the rest of the jobs
may run every day.

— Threshold Run Time (Sec)

Amount of time greater than which the job is deemed long running. If a
Threshold Run Time is specified here, then a job is deemed long running if
its current run time exceeds that value. Otherwise, if a Threshold Run
Time is not specified, then the job is deemed long running when its current
run time exceeds the Long Run Average Time Multiplier (defined on the
Edit Settings popup of the System Configuration screen) times the
average run time of that job. For example, if a job's average run time is 3
minutes, and the Long Run Average Time Multiplier is 3, then the job is
considered long running if it has been running for at least 9 minutes. A
notification is sent when a job is deemed long running.

2. Add Existing Job

Add Existing Job
" Select Cycle | Adhoc -
* SelectJob | AGG_SRVC_JOB -

Ok Ok and add another

3. Import Job from Existing Process
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Import Job from Process

" Select Process COPY_W_RTL_MARKET_PROD_DH_MTX_DS_PROCESS >

Cancel Ok

After creating and adding jobs for the new process, click the Create button in the
footer to create the custom process with its associated jobs.
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[ e

The custom process and its jobs are created and displayed in the Standalone tab. A cusToM

tag is also seen along with the process name to indicate that it was a custom, user-created
process.

Enable the Custom Process

The custom process is disabled by default and can be enabled by clicking the enable/disable
switch.
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Edit the Custom Process

The Custom Process can be edited by clicking the Edit icon below the flow name to
edit the process details and add/edit/delete jobs.

Oracle Retail Process Orchestration and Monitoring

Jobs in New Process
Aders ¢ em v TV Poma 4+ +
Emabled Job Mame Dwicription o Application
CARATY_PARTITION UM Y08 n
ST .
WAL MEAL e e, €0 "

Delete the Custom Process

The Custom Process can be deleted by clicking the Delete icon below the flow name.
For audit purposes, a comment is required when deleting a custom process.

Batch Job Details

The Batch Job Details screen allows maintenance of various types of dependencies
associated with a batch job.
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CONTROL_FILE_VALIDATION_PROCESS

Process

AdhoFlow_Process_solo

Process

AdhetFlow, Process_solo

Schedule

RAPASCE Remave

Schedule

RPASCE Remave

This section displays the following information about a job's pre-dependencies:

* Enabled - Switch to enable or disable the pre-dependency.

e« Job

e Process

Post Dependencies

This section displays the following information about a job's post-dependencies:

e Enabled - Switch to enable or disable the post-dependency.

e Job

e Process

External Dependencies

ORACLE

This section allows for the maintenance of the following information about a job's external
dependencies. An external dependency is normally a process internal to a customer's

system.

* Enabled - Switch to enable or disable the external dependency.

e Job

* A Remove button is available to delete the external dependency.
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Inter-Schedule Dependencies

This section allows for the maintenance of the following information about a job's inter-
schedule dependencies. An inter-schedule dependency is a dependency for the
current job on a job belonging to another batch schedule. The job for which this Jobs
Detail screen is shown will wait for the job entered here.

» Enabled - Switch to enable or disable the inter-schedule dependency.
» Job - Name of job belonging to the other schedule.

» Process - Name of process containing Job.

*  Schedule - Name of other schedule containing the dependency.

A Remove button is available to delete the inter-schedule dependency.

Schedule Links

This section allows for the maintenance of the following information about schedule
links for a job. Schedule links are a way to link schedules together where the
completion of the job in the current schedule causes the start of execution of the
dependent schedule.

* Enabled - Switch to enable or disable the schedule link.
e Job - Name of job belonging to the dependent schedule.
e Process - Name of process containing Job.

e Schedule - Name of the dependent schedule.

A Remove button is available to delete the schedule link.

Scheduler Administration

The Scheduler Administration screen displays information about the different cycles'
Scheduler tasks and allows for their administration.

When an application's batch schedule is initially seeded in POM, Scheduler tasks are
created for each of the different Nightly, Recurring, and Standalone cycles. An
administrator would then access the Scheduler Administration screen to configure the
execution schedule for all available tasks according to customer's needs.

¢ Note:

Scheduler tasks are not automatically seeded for Adhoc Custom Entities that
are created using the Create Custom Entities button on the Batch
Administration screen. Scheduler tasks for these custom entities need to be
manually added using this Scheduler Administration screen.

A scheduler task can be configured in one of many frequencies as depicted in the
table and Edit task screenshot below:
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Frequency Description

Daily Run daily at the specified time

Once Run once at a specified date and time

Weekly Run every <day of a week> at the specified time
Monthly (By Date) Run on a particular day of each month at a specified

Monthly (First Day of the Month)
Monthly (Last Day of the month)
Monthly (By Weekday)

time; for example, on the 15th of each month at 10pm
Runs at the beginning of every month
Runs at the end of every month

Runs on the First/Second/Third..../Last weekday of the
month. For example, Second Wednesday of the month

The Standalone (or Adhoc) cycle support a recurrence within each of the above frequencies.

Recurrence Description

Single Will run just once at the time defined on the
frequency

Multiple Will run multiple times at regular intervals starting at

the time defined on the frequency

The following are restrictions enforced on scheduler task frequencies:

* Recurring cycle supports only Daily frequency. It does not support the MULTIPLE

recurrence.

* Nightly cycle supports only Daily and Weekly frequencies. It does not support the

MULTIPLE recurrence.

*  When Nightly is setup with Weekly frequency, it needs to be setup for every day of the
week. This is due to the fact that when Nightly completes for a certain day, it sets up the
schedule for the next business day which cannot be skipped.
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Figure 2-51 Edit Scheduler Task Window

Edit Task W_DOMAIN_MEMBER_LKP_TL_PROCESS_ADHOC

Enabled (@)
Description fest
Schedule Time Zone  (UTC+05:30) Calcutta - India Standard Time -
Frequency | Monthly (by Weekday) hd
Schedule Details Daily

Prevent start during nightly  Once
Run Every \weekly ¥ at| 600PM
Recurrences  Monthly (by Date) ery 2 Minutes
Monthly (First Day of Month)

Monthly (Last Day of Month) Cancel ok

Monthly (by Weekday)

It is important to note that POM considers the POM business date, not the system
date, to identify the day/ date, while scheduling tasks.

Nightly Scheduler Task Administration

On the Scheduler Administration screen, the user selects a schedule tile at the top of
the screen and the Nightly tab right below the tile area. The Nightly cycle's Scheduler
task is shown in the tasks table of the figure below.

¢ Note:

There is only one Nightly Scheduler task, as there is only one Nightly batch
run.

ORACLE" 2-88



Chapter 2
Scheduler Administration

Figure 2-52 Nightly Scheduler Task Administration

Oracle Retail Process Orchestration and Monitoring

Scheduler Administration  x

o] RI22230356 O MERCH2222 O RPASCE 276
Nighthy: 1 Nightly: 1 Nightly: 2
9 Recurring: 24 Recurring: 2304 Recurring: L]
N Standalone: O Standalone: 4 Standalone: 29

Mightly (1) Recurring (2304) Standalone (4)

MERCH Nightly Scheduler Task
= V E Detach

Actions ¥ View ~

Filte - Filter Filter

Enabled © Flow Name & Task Configuration o

@) ves Nighly Run Every Day At 1559 PM (UTC), 1 Time

The user selects the only row available for the Nightly task, clicks the edit icon then edits the
scheduler configuration in the Edit Task Nightly popup. The popup includes the following
schedule information for the Nightly task:

Edit Task Nightly
Enabled (1D

Schedule Time Zone | (UTC-06:00) Chicago - Central Time
Frequency | Weekly
Schedule Details

Run Every = Tuesday ¥  at | 1Z00PM

Run Every = Thursday ¥ | at | 08:00AM

+ Add Another

Cancel 0Ok

 Enabled/Disabled

e Scheduled Time Zone

* Frequency - Possible values are: Daily, Once, Weekly, Monthly (By Date), Monthly (First
Day of Month), Monthly (Last Day of Month), and Monthly (By Weekday). However, only
the Daily and Weekly frequencies are feasible for the Nightly cycle.
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* Schedule Details - Based on the Frequency selection, the Schedule Details
refreshes accordingly:

— Frequency: Daily 'Run Every Day At' <Time AM/PM>.Note that when using the
Daily frequency, Nightly will run at the same time every day.

— Frequency: Weekly 'Run Every' <Day of the week> 'at' <Time AM/PM>.Add
Another: Adds another weekday for the same task. Note that when using the
Weekly Frequency for the Nightly cycle, it needs to be scheduled for every day
of the week. Also note that by using the Weekly Frequency, you can schedule
Nightly to run at different times on different days.

— Selecting any of the other frequencies (Once or any of the Monthly modes)
results in Error Message: Nightly cycle supports only Daily and Weekly
frequencies.

Recurring Scheduler Tasks Administration

On the Scheduler Administration screen, the user selects a schedule tile at the top of
the screen then the Recurring tab right below the tile area then the hourly flow from the
drop down to the right of the Recurring tab. The Recurring flow's Scheduler tasks are
shown in the tasks table.

Figure 2-53 Recurring Scheduler Tasks Administration

Oracle Retail Process Orchestration and Monitoring

re Scheduler Administration
o RI22230356 © MERCH2222 © RPASCE 2.76
Nighthy: 1 Nightly: 1 Nightly: 2
E’ Recurring: 24 Recurring 2304 Recurring: o
Standalone: 0 Standalone: 4 Standalone: 29
Nightly (1) | Recurring (2304) | Standalone (4) Hourly_Cycle_3 -

MERCH Hourly_Cycle_3 Scheduler Tasks
Actions ¥  View ¥ & 2 Y | K oetach
Fite v || Filer Filter
Enabled < FlowName < Task Configuration &

STORE_ORDERS_PURGE_CYCLE Run Every Day At 0:00 AM (UTC), 1 Time
Run Every Day At 0:00 AM (UTC), 1 Time
Run Every Day At 0:00 AM (UTC), 1 Time
Run Every Day At 0.:00 AM (UTC), 1 Time
Run Every Day At 0:00 AM (UTC), 1 Time
Run Every Day At 0:00 AM (UTC), 1 Time
Run Every Day At 0:00 AM (UTC), 1 Time
Run Every Day At 0:00 AM (UTC), 1 Time
Run Every Day At 0:00 AM (UTC), 1 Time
Run Every Day At 0:00 AM (UTC), 1 Time

Run Every Day At 0:00 AM (UTC), 1 Time

LTCLEPCUEET

Run Every Day At 0:00 AM (UTC), 1 Time
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The user selects a task in the table, clicks the edit icon, then edits the scheduler configuration
in the Edit Task popup. The popup includes the following schedule information for the
selected task:

Edit Task RI_INTRADAY_CYCLE

Enabled )
Schedule Time Zone = (UTC+05:30) Calcutta - India Standard Time b
Frequency = Daily w

Schedule Details

Run Every Day At 12:00 PM

Cancel Ok

 Enabled/Disabled
e Scheduled Time Zone

* Frequency - Possible values are: Daily, Once, Weekly, Monthly (By Date), Monthly (First
Day of Month), Monthly (Last Day of Month), and Monthly (By Weekday). However, only
the Daily frequency are feasible for the Recurring cycle.

e Schedule Details - Based on the Frequency selection, the Schedule Details refreshes
accordingly:

— Frequency: Daily 'Run Every Day At' <Time AM/PM>.

— Selecting any of the other frequencies (Once, Weekly or any of the Monthly modes)
results in Error Message: Recurring cycle supports only Daily frequency.

Standalone Scheduler Tasks Administration

In the Scheduler Administration screen, the user selects a schedule tile at the top of the
screen and the Standalone tab right below the tile area. The Standalone cycle's Scheduler
tasks are shown in the tasks table.
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Figure 2-54 Standalone Scheduler Tasks Administration

—

=] MERCH 230001 | © MEW.QW!E
Nighil 1 Nightly: 1

Recurring: 2458 Recuring: O
Stendalore 16 Standslone: 30

imuym Rwcurrin g (0} Sunddnnalm:

RPASCE Adhoc Scheduler Tasks
[+] ; x® o I |
Actions ¥ View ¥ J Z Y | B} petsch
AdhocFlow || e Fites
Name & Type @ Task Configuration &
AdthoeFlowTest! Flenw Foan Every Day At 1200 AM (UTC)
AdhocFlowTest2 Flow Run Weeekdy: Mon - 100 AM, Tue - 2:00 AM, Wed - 3:00 AM, Thu - 4:00 AM, Fri - 5200 AM, Sa1 - 6:00 AM, Sun - 700 AM, (UTC) Show More Details

If the row’s Task Configuration column contains a Show More Details link, clicking the
link opens a pop-up window displaying the task's schedule.

The user can either edit the schedule time for each task in-line, or select a task then
click the edit icon to change any of the fields shown in the Edit popup below.

The user selects a task in the table, clicks the edit icon then edits the scheduler
configuration in the Edit Task popup. The popup includes the following schedule
information for the selected task:

The user can also create and delete Standalone scheduler tasks.

¢ Note:

The user has the option to enter a blank time as long as a frequency in
minutes is entered. This will cause the first occurrence to execute
immediately.

ORACLE"
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Edit Task RDE_EXTRACT_CE_DIM_INITIAL_ADHOC

Enabled )
Description
Schedule Time Zone | (UTC+05:30) Calcutta - India Standard Time v
Frequency = Weekly hd
Schedule Details
Prevent start during nightly ‘:] X
Run Every = Thursday ¥ | at| 0145PM
Recurrences 1 Time
Prevent start during nightly 'j X
Run Every = Friday v |at 0423PM
Recurrences | 2 Times Starting Every 7 Minutes

+ Add Another

Cancel Ok

< Note:

The Prevent start during nightly switch prevents the task from running while the
Nightly batch is running. However, it won’t stop a run that is in progress when the
Nightly process starts.

 Enabled/Disabled
e Scheduled Time Zone

e Frequency - Possible values are: Daily, Once, Weekly, Monthly (By Date), Monthly (First
Day of Month), Monthly (Last Day of Month), and Monthly (By Weekday).

e If the 'Recurrences' is more than 1, then 'Starting Every n Minutes' has to be specified.

e Schedule Details - Based on the Frequency selection, the Schedule Details refreshes
accordingly.
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Schedule Maintenance

ORACLE

The Schedule Maintenance screen displays information about the batch schedule
upgrade results. You can upgrade a batch schedule to a new version through this
screen.

Figure 2-55 Schedule Maintenance Tab

Oracle Retail Process Orchestration and Monitoring A Retaliser ¥ @ ¥

Batch Jobs Timeli >

Audit Events

Schedule Maintenance X

System Configuration Batch Administration Scheduler Administration

Nightly Batch Summary
< AIF APPS 0.0.0.0 1

Date Upgraded i Actions | l

04/05/2323:55:10 GMT+530 NA Viewlogs  Retry

ARPS0000 @

PLANNING 1.3 | | © MERCH23.0101 | | @ TEST0.000 |@ AFDATATESTING.. @ DFDF 0.0.0.0

Error on Stage 7

QB %
<]

=)

Versions 2

Version

Import Latest Schedule

Upgrade Status Description

@  Error (Stage EXPORT_CURRENT_CONFIGURATION) 230101 Cancel

@  Error (Stage CREATE_TEMP_SCHEDULER_DAY) 193 04/05/23 2557:26 GMT+5:30 Merch Batch Schedule ViewlLogs  Retry ‘ Skip Failed Stage

O PastVersion 192 02/17/23 2011032 GMT+5:30 NA Viewlogs @ Upgrade

@ AutoRefresh: | N... ¥ | Lastrefreshed: 20/04/231126:28 | Refresh

1. Batch Tiles - There is a batch tile for each schedule available in Process
Orchestration and Management. Select a tile to show the history of the selected
schedule's upgrades or available upgrades.

2. Import Latest Schedule - Use this button to upgrade the selected schedule from
a spreadsheet. When clicked, a file selector dialog is displayed (not shown).

The import file is a spreadsheet.

3. Update History Status List - Displays information about each past or available
upgrade of the batch schedule. This menu displays the following information for
each batch upgrade:

* Upgrade Status
*  Version
* Date Upgraded
*  Description

4. Actions

* Upgrade - Use this button to upgrade the schedule. This button only appears
for schedules for which an upgrade available.
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* Retry - Use this button to retry a failed update. This button only appears for
schedules that have not completed successfully. The retry will resume the upgrade
from the failed step.

» Cancel - Use this button to cancel the upgrade for an ongoing upgrade as long as it's
in stage 4 or less, or to cancel an upgrade in an error state.

When an ongoing upgrade is cancelled, it is marked as Error. The user can then
either click the Cancel button again to remove the attempted upgrade so it can be
started over or click the Retry button to resume the upgrade from the failed step.

*  View Logs - Use this button to view the schedule import log for the selected
schedule. The log displays the list of activities completed as part of the schedule
import along with the status, timestamp and other information such as success log,
error message, skip reason, and so on).

»  Skip Failed Stage - Use this button to skip the current stage at which the schedule
upgrade has failed. This is usually done if the upgrade process is at a stage after the
upgrade and you want to ignore failures such as Health Check for now, as you intend
to address it later.

MERCH 23.0:102 Schedule Import Log

¢ CLOBIIMACTIVE_SCHEDULER. B - COMPLETED, | (/7071 55t L7100 03645 )

Frund oo schedler iy Tou Fob M 000100 LITE 2, chosing.

¥ EXPOAT_CURSINT. TH RS |

3 GEMERATE_POM_

5. Download files menu - Use this menu to download schedule files. See Download Files for
more information.

Actions

View Logs E

Download Previous Configuration

Download POM Seed File

View Logs -
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Download Files

Click on the ellipses then select from the download files menu to download files for an
upgrade version. This menu has the following options:

» Download Previous Configuration
* Download POM Seed File

Download Previous Configuration

Use the Download Previous Configuration option to download a file containing the
specific schedule version configurations. This file is in JSON format.

Download POM Seed File

Use the Download POM Seed File to download an SQL file with POM seed data for
the specific schedule version.

Footer

The screen can be set to auto refresh periodically by selecting the pre-defined interval
from the Auto Refresh list. By default, this value is set to 30 minutes on page load
which means the Auto Refresh is turned off.

Use the Refresh button to refresh the screen immediately.

Last refreshed shows the time and date of the last refresh of the interface.

AMS Ultilities

The AMS Utilities are functions performed only by the Oracle administrators.

Select AMS Utilities from the Tasks menu to display the submenu.
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Menu

* Batch Monitoring
ol System Configuration
Batch Administration
Scheduler Administration

Schedule Maintenance

AMS Utilities >

Xy < AMS Utilities
_ Q Search for a task

@ Manual Job Run

ol Override Job Status

Override Execution Requ...
Audit Events

Align Business Dates

The AMS Utilities submenu contains the following tasks:

e Manual Job Run

e Override Job Status
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* Override Execution Request Status

e Audit Events

» Align Business Dates

Manual Job Run

An Oracle administrator uses the Manual Job Run utility to run a job for a particular
schedule from either the Nightly or Hourly cycle. Once the selections are made, the
user clicks on Run to submit the job for execution. The user then uses the Batch
Monitoring screen to monitor the execution of the job.

" Note:

A job that is manually run on this Ul is run standalone without regard to
dependencies.

Figure 2-56 Manual Job Run

Manual Job Run

Running a Job manually would simply run the job without regard to its dependencies. These Jobs will not be re-run when the Cycle is running.

Schedule
RPAS

-

Cycle
Nightly

-

Job
AP_BATCH_AGG_END_JOB

Run

Override Job Status

The next AMS Utility is Override Job Status.

Occasionally, a job in POM gets stuck with a status where manual intervention is

needed. This is to reset the status and get the job running for instance. This screen is
used for this purpose.
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Figure 2-57 Override Job Status

Override Job Status X

Find Job
Schedule
RPAS -

2 .
e | Nightty | Recorring. | Stendelone

RPAS Jobs - Standalone

Ations ¥ View ¥ 2 YW B oetach
Status = Job = Process Name T Start Time = End Time = Last Update =
@ Error adio AP_ADHOC_10_PROCESS. D4/2/IBZOOTIIGMT+SI0  O6/2623200735GMT+530  08/26/23 200733 GMT+5:30
0 Losded dé Directive_Process 06/26/23 588 GMT530
o Loaded b Directive_Process 06/26/23 5818 GMT+530

Select the schedule and the cycle to display all jobs for those selections in the Jobs table.

In the table, select the row for the job you intend to override the status for and click the
Change Status button or select Change Status from the table's Actions menu. The Change
Status popup is displayed.

Change Status of Job ad10

Warning

Excercise extreme caution when overriding a job status as it may lead to
unexpected results including data corruption.

Business 23/06/23
Date

New Status
-
Comments
Loaded is at least fifteen non-repeating
Completed
R red
Error Sl
Cancel oK

You are required to enter a comment justifying overriding the job's status.

Notice the warning message. An administrator needs to understand the impact of overriding
the status as it may lead to data corruption if an unintended action takes place.

Override Execution Request Status

ORACLE

The next AMS Utility is Override Execution Request Status.

Occasionally, a job in the POM's Execution Engine gets stuck with a status where manual
intervention is needed. This is to reset the status and get the job running for instance. This
screen is used for this purpose.
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Figure 2-58 Override Job Execution Status

Overridle Execution Req... X

Find Job

Schadule | |
RPAS -

Mightly = Recurring  Standalone

Cycle

RPAS Execution Requests - Standalone

Agtions ¥ View ¥ 2 Y ) pewen

Filter
Execution . - - - Total .
" < Status © Cycle = Flow © ot
&M O Loaced Adhos Adhee 2

Execution ID 601 Details

Actions ¥ View ¥ 2 | Y | K ostach

2 Job

::m ¢ Status © Job Name 2 Process © Eonitonin. * Last Update &
E509S €3 Enoe adil AP_ADHOC_10_PROCESS 4001 08/26,/25 2r07-38 GMT +5:30
2550694 10 Loaded AP_ADHOC_10_308

AP_ADHOC_10_PROCESS

Select the schedule and the cycle to display all jobs for those selections in the Jobs
table.

Select the row in the Details table for which you intend to override the status and click
the Change Status button or select Change Status from the table's Actions menu.
The Change Status popup is displayed.

Change Status of Job ad10

Warning

Excercise extreme caution when overriding an execution request status as it
may lead to unexpected results including data corruption.

Business  23/06/23

Date
New Status
-
Comments E ;
Loaded is at least fifteen non-repeating
Completed
Required
Error ==

Cancel OK

You are required to enter a comment justifying overriding the job's current status.

Notice the warning message. An administrator needs to understand the impact of

overriding the current status as it may lead to data corruption if an unintended action
takes place.
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Audit Events

An Oracle administrator uses the Audit Events utility to view the list of audit events
associated with the selected schedule. Whenever the system or user triggers any of the
actions listed below, a corresponding audit event is created with the related details. Here’s a
sample screen listing some sample audit events.

SOCDCTRACT C0DM P RO EXTRACT CE_ D4 b

mmmmmm POy —

The actions that trigger an audit event are listed below:

# Screen Actions

1 Batch Monitoring *  Manual Close/Create/Restart scheduler day
* Job actions (Run/Hold/Skip and so on)
*  Enabled/Disable Scheduler
¢ Suspend/enable the Schedule
e Schedule task creation or manual run
*  Enable/disable dependencies
e Manual Flow Run
e Manual Process Run
*  Cycle Recover
e Update Job Parameter
2 Batch Administration *  Enable/Disable Jobs
¢ Job configuration update
*  MDF Sync
¢ Export/Import configuration
—  Schedule Config
—  Custom Entities
¢ Custom Batch Entity (Create/Update/Delete)
* Enabled/Disable Invokable
*  Enable All/ Disable All action
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# Screen Actions

System Configuration ¢ Update environment settings (URLS)
e Update / Remove external configuration
¢ Update System settings
¢ Create/Update/Delete of custom job type
*  New Schedule Creation
e System Option Update

4 Scheduler * Enable/disable a scheduler task

Administration «  Configuration update

e Scheduler Task delete

Schedule Maintenance <«  Schedule upgrade
AMS Utilities ¢ Manual job run

* Execrequest status update
* Job status update

Align Business Dates

An Oracle Administrator uses Align Business Dates to align the business dates for
the schedules.

The Schedules Configuration screen shows all available schedules and their statuses.

Oracle Retail Process Orchestration and Monitoring

Batch Monitoring

Align Business Dates X

: .
Schedules Configuration
Actions ¥ View & ? E Detach Align Business Dates
III] ” Current Business o~ " Scheduler Day "
Schedule Name © Date ¢ Dependent Schedules © Status ¢
RI 2023-05-15 RSP © Active
Test-Merch 2023-05-27 NO_DEPENDENCIES @& Completed
RSP 2023-05-14 RI © Active
TEST 2023-05-23 MO_DEPENDEMNCIES o Active
RPASCE 2023-05-30 MO_DEPENDEMNCIES o Active

Select the Schedule Name and click the Align Business Date button to align the
business date for a schedule.
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Align Business Dates for Rl

Note

Aligning the business dates will impact the currently running batches and also
scheduler day would be restarted after the business dates alignment. If Update
Dependent Schedules toggle is enabled, business dates would be aligned for the
selected schedule (Rl) and dependent schedule(s) (RSP).

" Business Date

Required

Advance Date Only @ [l Disabled

Update Dependent Schedules @ () Disabled
* Comments Enter comments for auditing

Required

Cancel oK

Select a Business Date, add Comments and click the OK button to align that business date
for the selected schedule.

Optionally, toggle the Advance Date Only switch to enforce only business date advancement
for the selected schedule and for the dependent schedules if applicable. You can also toggle
the Update Dependent Schedules switch to enforce business date alignment for all inter-
schedule dependent schedules and for schedules linked through execution links.

Select Reports from the main menu to display the submenu.

Menu

¢

=

Reports

Q, Search for a report

Nightly Batch Summary

m Batch Jobs Timeline
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Nightly Batch Summary

The Nightly Batch Summary displays a configurable Batch Summary report, which
displays Nightly cycle statistics across select schedules.

. o Fatres ¥ e tion ® Zero Felum e

g4
=]
@ . arage Dusation oo S——
o

#4860 A 4b.29(min) ezl 1
Compaborsh  Curent Month et et e
2 28.0%min} W/

Batch Timings

TR

Click the Options button to select the month and schedule(s) for which the report is to
be run. All the schedules are populated by default and can be added or removed as

needed. The Switch to Current Month button resets the summary report to the
current month.

Options

* Select Month ‘ March- 2023 v ’

* Select Schedule | | MERCH X || EBSD-3222 X || RI X | RSP X |

] |

Switch to Current Month

The statistics displayed as tiles are,

e Total Failures
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» Target Misses for the current and previous month

A red icon in the top left corner indicates that the statistics count is a serious concern that
needs to be addressed. A blue icon indicates a neutral status and green icon indicates an

acceptable failure count.

Tile# 1 - Total Failures

Total Failures

4660
Current Month

2

Previous Month

Total Failures e Total Failures
2 28

Current Month Current Month
N/A 660

Previous Month Previous Month

This tile displays the total batch failures for the selected month and schedules. The previous
month’s failure count is also displayed for comparison.

Tile# 2 - Average Duration

— Average Duration

4 66.29(min)
Current Month

28.09(min)

Previous Month

Average Duration

28.09(min)
Current Month

N/A

Previous Month

Average Duration

12.00(min)
Current Month

66.29(min)

Previous Month

ORACLE
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This tile displays the average duration of a batch cycle for the selected month and
schedules. The previous month’s average duration is also displayed for comparison.

Tile# 3 — Zero Failure Days

Zero Failure Days

22/31
Current Month

18/28

Previous Month

Zero Failure Days

41/30

Current Month
22/31

Previous Month

This tile displays the count of the days when a batch completed execution without any
failure for the selected month and schedules. The previous month’s Zero failures count
is also displayed for comparison.
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Tile# 4 — Target Misses

Target Misses

1
Current Month

1

Previous Month

Target Misses

1

Current Month
0

Previous Month

Target Misses

0
Current Month

1

Previous Month

The Target Batch Duration is a threshold that can be set at the schedule level at provisioning
time. It can also be added or modified on the System Options screen accessed from the
System Configuration screen. This system option’s key is TARGET BATCH DURATION. A target
miss occurs when batch duration for a schedule exceeds this threshold. The Target Misses
tile displays the miss count for the month along with the respective Arrow icon color.

Batch Timings Bar Graph

ORACLE

Batch Timings

The Batch Timings bar graph by date, shows the Schedule Name(s) in the right margin, along
with a bar for each day of the month. Each bar represents a stacked nightly batch duration
per schedule for that day.
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Batch Timings

14K Series MERCH
Group 13
Value 1.290K

1.2K

1.0K

0.8K

Batch Failures

Batch Failures

By Week
Week ¢ RI < RSP ¢
Week 1 0 0
Week 2 0 0
Week 3 382 148
Week 4 0 0
Week 5 0 130

The Batch Failures section of the report provides the total batch failures on a weekly
basis for the selected schedules and month.

Batch Jobs Timeline

The Batch Jobs Timeline report displays the timeline of the jobs executed for the
selected Business Date, Schedule, and Cycle. The Batch Jobs Timeline can also be
accessed by clicking the Download Cycle Summary button, then Open Report from
the Batch Monitoring screen for a completed schedule.
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il

&® ﬁ:—:: =] e = D:., =
s
AIF Nightly 2023-03-14
|' if
Time 7:36
Jobs 2
[
7:33 AM 734 AM 7:35 AM 7:36 AM 737 AM 7:38 AM 7:39 AM 7:40 AM /
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Roles are used to classify users based on job responsibilities and actions to be performed in
the Oracle Retail Process Orchestration and Monitoring application (POM). Using roles, a
user's access can be restricted to specific areas or functions within the application. In POM,
users must be associated with at least one job role in order to access the application.

The following topics are covered in this chapter:
Roles

Functional Access by Role

POM comes available with a set of pre-defined roles described in the table below. In addition
to the roles, the table contains an alias for each role which is used in the next section for
easier reading.

# Note:

The first two roles have thus far been associated with POM's classic user interface
and are being deprecated along with the classic user interface itself. Customers
need to migrate to the other four roles before those classic roles are removed.

These roles have been given similar access in the new user interface as the access
they had in the classic user interface.

Table 3-1 Roles

- _____________________________________________________________________________|
Role Alias Description

BATCH_MONITORING_]JOB Monitor One of the classic user interface roles.
Users within this role are typically
retailer administrators responsible for
monitoring and executing batch. They
can perform select activities on the
Batch Monitor screen to move the
schedule along.

BATCH_BUSINESS_JOB Business User Another one of the classic user
interface roles. Users within this role
are typically retailer business users
responsible for just monitoring batch
and configuring POM to enable
callbacks into the Company's systems.
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Table 3-1 (Cont.) Roles

- _____________________________________________________________________________|
Role Alias Description

BATCH_ADMINISTRATOR_JOB Administrator Users within this role are retailer
administrators with full access to all
POM actions. They monitor, maintain
and configure the batch schedules.
They may also maintain POM
application configurations for efficient
operations. They troubleshoot batch
issues and work with Oracle support
personnel to address those issues.
Finally, they may apply batch schedule
patches and upgrades.

Additionally, users assigned this role
are given access to the Oracle AMS
Utilities screen.

BATCH_VIEWER_JOB Viewer Users within this role are retailer
business users responsible for just
monitoring batch. They have view
access to all POM screens except AMS

Utilities.
BATCH_SCHEDULE_CONFIGURATIO Schedule Config Users within this role are typically
N_MANAGER_JOB Mgr retailer administrators responsible for

just monitoring batch and configuring
external dependencies and callbacks
into the Company's systems. They have
view access to all POM screens except

AMS Utilities.
BATCH_SCHEDULE_ADMINISTRATO Schedule Admin Users within this role are typically
R_JOB retailer administrators responsible for

maintaining, monitoring and executing
batch. They have view access to all
POM screens except AMS Utilities. They
can perform select activities on the
Batch Monitor screen to move the
schedule along. They also have update
access to the Batch Administration
screen. They can also configure some
application properties and can
configure a new schedule

BATCH_ORACLE_AMS_ADMINISTRA AMS Admin Users within this role are typically

TOR_]JOB Oracle AMS administrators who
monitor, maintain and configure the
batch schedules. They also maintain
POM application configurations for
efficient operations. They troubleshoot
batch issues and work with other
Oracle development and support
personnel to address those issues.
Finally they apply POM and batch
schedule patches and upgrades.
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Functional Access by Role

This section lists all roles that have update access for each functional aspect of every screen.
It is organized by screen, except for the first two tables.

ORACLE

Table 3-2 External Integration

Chapter 3
Functional Access by Role

Schedule Admin
Administrator

Feature Roles (aliases) with access
Invoking batch execution Monitor
from an external system
Requesting the status of a
batch execution .
AMS Admin

Releasing dependency on an
external process

Table 3-3 POM Task Menu

Feature

Roles (aliases) with access

Show Batch Monitoring task

Show System Configuration task

Show Batch Administration task

Show Scheduler Administration task

Show Schedule Maintenance task

Show AMS Utilities task

Monitor

Business User
Administrator
Viewer

Schedule Config Mgr
Schedule Admin
AMS Admin

Business User
Administrator
Viewer

Schedule Config Mgr
Schedule Admin
AMS Admin

Administrator
Viewer

Schedule Config Mgr
Schedule Admin
AMS Admin

Administrator
Monitor

Schedule Admin
AMS Admin
Administrator
Viewer

Schedule Config Mgr
Schedule Admin
AMS Admin

AMS Admin
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Table 3-4 Screen: Batch Monitoring

Chapter 3
Functional Access by Role

Feature

Roles (aliases) with update access

Buttons for Create Schedule, Close
Schedule and Restart Schedule

Jobs table on Batch Monitoring screen -
Buttons for Run, Rerun, Hold, Release, Skip,
Release Skip, and action for Add Comments

Jobs table Actions menu on Batch
Monitoring screen - Edit Parameters (for
selected job)

Job Details screen - Enable/Disable External
Dependencies

Job Details screen - Retry Schedule Link
button

Job Details screen - Retry Callback button

Execution Engine display Configuration

Download Job Log
Download Cycle Summary
Scheduler Tasks Monitoring and actions

Monitor
Schedule Admin
Administrator
AMS Admin
Monitor
Schedule Admin
Administrator
AMS Admin
Monitor
Schedule Admin
Administrator
AMS Admin
Monitor
Administrator
Schedule Config Mgr
Schedule Admin
AMS Admin
Monitor
Administrator
AMS Admin
Monitor
Administrator
AMS Admin
Administrator
AMS Admin

All authenticated users
All authenticated users

Monitor
Administrator
Schedule Admin
AMS Admin

Table 3-5 Screen: System Configuration

Feature

Roles (aliases) with update access

System tab - Update actions

Schedule tab - Update actions for general &
environment settings

Schedule tab - Job agent system options
dialog

Administrator
AMS Admin

Administrator
AMS Admin

Administrator
AMS Admin
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Chapter 3
Functional Access by Role

Table 3-5 (Cont.) Screen: System Configuration

Feature

Roles (aliases) with update access

Schedule tab - Update actions for MDF
configuration

Schedule tab - Update actions for job agent
throttling configuration

System tab - Update actions for external
configurations

Global Edit - Settings updates

Global Edit - External Configuration
updates

Configure New Schedule

Administrator
AMS Admin

Administrator
AMS Admin

Business User
Administrator
Schedule Config Mgr
Schedule Admin
AMS Admin

Administrator
AMS Admin

Business User
Administrator
Schedule Config Mgr
Schedule Admin
AMS Admin
Administrator
Schedule Admin
AMS Admin

Table 3-6 Screen: Batch Administration

Feature

Roles (aliases) with update access

Export Config and Import Config buttons

Enable/disable switch on each of the Recurring

Flows and Jobs within each Flow

Jobs table on main UI - Edit and Enable/Disable

actions

Batch Job Details - Enable/Disable
Dependencies

Batch Job Details - Create/Enable/Disable/
Delete Inter-Schedule Dependencies

Batch Job Details - Create/Enable/Disable/
Delete Schedule links

Administrator
Schedule Admin
AMS Admin
Administrator
Schedule Admin
AMS Admin
Administrator
Schedule Admin
AMS Admin
Administrator
AMS Admin
Administrator
AMS Admin
Administrator
AMS Admin
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Chapter 3
Functional Access by Role

Table 3-6 (Cont.) Screen: Batch Administration

Feature Roles (aliases) with update access
Batch Job Details - Create/Enable/Disable/ Administrator
Delete External Dependencies Schedule Config Mgr
Schedule Admin
AMS Admin
Create/Edit/Delete Custom Adhoc Entities Administrator
Schedule Admin
AMS Admin

Table 3-7 Screen: Scheduler Administration

Feature Roles (aliases) with update access
All Functions on the Scheduler Monitor
Administration screen Administrator

Schedule Admin

AMS Admin

Table 3-8 Screen: Schedule Maintenance

Feature Roles (aliases) with update access

All actions: Import Latest Schedule button, Administrator
Upgrade, Retry buttons in table row AMS Admin

Download Configuration and download
POM seed data

Table 3-9 Screen: AMS Utilities

Feature Roles (aliases) with update access
Manual Job Run Administrator
Override Job Status AMS Admin

Override Execution Request Status
View Audit Events
Align Business Dates

Table 3-10 Screen: Application Properties

Feature Roles (aliases) with update access
Application Properties Schedule Admin

Administrator

AMS Admin
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